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Introduction 1

DocuShare product editions

Xerox DocuShare provides several product editions. Depending on which product edition
you are using, certain features and add-ons are available.

DocuShare documentation describes all product features and add-ons. Refer to the below
table to see which features and add-ons are available for your use.

Table 1-1: Product comparison

DocuShare DocuShare DocuShare
DocuShare

Express Education Enterprise

Document Check-in /

Check-out and Version L ° ° °
History

Access Permissions L ° ° °
Expanded Permission Set 1 o ] ]
Full Text and Property . . o o

Indexing and Search

Notifications ° ° ° °
Change History / Activity ° ° ° °
History

Document Routing and . . o o
Approval

Side-by-Side Document

Content and Property d o ° °
Viewer

Scan Cover Sheets L ° ° °
Document Comments L L] (] ]
Weblogs and Wikis ° ° °
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DocuShare product editions

Table 1-1: Product comparison

Introduction

DocuShare DocuShare DocuShare
. DocuShare .
Express Education Enterprise

HTML Conversion hd hd hd hd
Custom Properties Creation d d b b
Custom Object Creation b d b
DocuShare SharePoint ° ° °
Integration
LDAP Support b d b
WebDAV Support hd hd d d
Product Add-ons
Archive Server Add-on Add-on Add-on
Content Encryption Add-on Add-on
Content Rules Manager
(content rules / workspaces Add-on Add-on hd
features)
Database Connectors Add-on Add-on i
eForms Add-on Add-on Add-on
Email Agent Add-on Add-on i
Federated Search Add-on Add-on d
OCR Service Add-on Add-on
PDF Conversion Add-on d b
Quick Search ° Add-on ° °
Records Manager Add-on Add-on
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Getting started 2

Overview

The DocuShare family of products allow you to easily and efficiently manage electronic

content using a web browser. Using DocuShare, you can create, organize, and share
content, collaborate with other users on projects, search for and retrieve content, and
automate work processes.

Key features in the products enable you to:

+ Create and maintain your own account and personal work area without the
assistance of a web master or site administrator.

« Add and control access to site content.

* Maintain multiple versions of a document, track its revision history, and lock a
document to prevent simultaneous editing.

+ Collaborate on content using wikis and weblogs.

»  Scan paper documents to site locations.

* Route documents for approval or review.

» Create project-oriented areas for managing the content, people, and tasks.

« Set up content rules to automate a work process.

User Guide
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Accessing DocuShare Getting started

Accessing DocuShare

You access DocuShare by entering the URL of your DocuShare site in a web browser
window. Depending on how your site is set up, you may be required to log in or you see
the DocuShare home page. From the site home page you can log in, as well as access the
content and features on your site.

Although your administrator can customize your site home page and different browsers
may not display site elements the same, your home page should look similar to the
example shown below.

| Xerox DocuShare’ Home | Content Iv .G elp D

Guest

Login using an

Communities

Explore our community areas
= Forgot your password? z

U me “ "
A ord Co administrator. g Wikis & Veblogs
o

more » more »

What's New

Lists all modified content. See what's new today! F

in the last hour  |»

Collections Other Links Getting Started G
Top level collections Links to other content Not sure what to do? Take a Tutoria
‘ Initial Top Level Collection A 74 WorkCentre Scan Repository
h/’ Temnporary storage for scanned
5 o, R documents
h/’ Initial Top Level Collection B
h) Initial Top Lewvel Collection C
h/“[ Initial Top Level Collection D
Home About DocuShare Login (As a Different User) CiHome
c Content Map Site Statistics My DocuShare
What's New Tutorials Personal Collection
Users & Groups DocuShare Downloads My Tasks
Help Docushare. xerox.com Account Settings (Guest)

The DocuShare home page includes these features:
A—Login area
B—The site’s top-level collections, which your administrator sets up

C—Page footer, which includes links to other DocuShare pages and related information
and displays your browsing history

D—Navigation bar, which includes links to other DocuShare pages and a search area for
running quick searches and accessing advanced search features

E—Access to community areas

F—What's New menu, which you can use to see the content that has been added or
changed

G—Help on getting started using DocuShare

2-2 User Guide



Getting started Navigating DocuShare

Navigating DocuShare

DocuShare navigation features make it easy to find what you need.
Navigation bar—Includes links to pages and features that are used frequently:

*  Home—returns to the home page.

+ Content Map—provides a hierarchical display of the objects on your site, based
on your current location. You can click any object in the Content Map to open it.
Depending on how your site is set up, this link may not appear.

*  What's New—lists the new and changed objects on your site.

* Users & Groups—provides links to listing, finding, and creating user and group
accounts.

* Help—provides access to user guides, tutorials, and software downloads.

« Username—displays your user account properties. Your username displays after
you log into DocuShare.

* Logout—Ilogs you out of DocuShare. The link displays after you log in.

* My DocuShare—displays your personal home page, which includes your favorites
and a personal collection and calendar. The link displays after you log in and on
pages other than the DocuShare home page.

+ My Tasks—shows the routing tasks assigned to you and the tasks you assigned.
The link displays after you log in.

+ Search area—includes an area for running quick searches as well as a link to the
Advanced Search page.

Go to menu—On a site with spaces, enables you to switch among spaces and the main
DocuShare site.

Page footer—In addition to including some of the same links shown on the navigation bar,
provides links to related information, personal pages, and account information and
displays your browsing history.

Breadcrumbs—Provide a path from the home page to your current location or list the last
few pages you visited. You can click any link in the breadcrumbs to go to the page. For
objects that appear in more than one location, multiple breadcrumbs are displayed when
you click the triangle under Location.

Location: Home > Initial Top Level Collection D > My Collection Listing
v
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Logging in and out Getting started

Logging in and out

Your administrator determines the access policies for your site. Therefore, you may be
able to browse and view content without logging in (as a guest) or you may be required to
log in before you can access any site content.

To log into DocuShare:

1.
2.

In a web browser, enter the URL of your DocuShare site.

In the Login area, enter your registered username and password in the fields.
Your password is case-sensitive.

In the Domain field, select your internal domain name (if applicable).

If the Retain login for future checkbox appears, click it if you want to remain
logged into DocuShare after you close and reopen your browser.

Note: The Retain login for future checkbox appears if your administrator
configured your site to allow users to remain logged in after closing their browser.
For DocuShare to save your password, Internet Explorer’s Do not save
encrypted pages to disk option cannot be enabled. You can check the option’s
setting by selecting Internet Options from the Tools menu and then clicking the
Advanced tab.

Click Login.

Your username appears on the navigation bar, indicating that you are logged in.

To log out of DocuShare:

1.

Do one of the following:
e Close the browser window.

+ If you selected the retain login for future checkbox, click the Logout link on
the navigation bar.

User Guide



Getting started How to get help

How to get help

In addition to this guide, the Help Desk includes other guides and a tutorial. The
Documentation page provides user guides for the features available on your site. The
Training page includes a User Tutorial, which helps you get started using DocuShare by
following a series of step-by-step exercises.
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Managing accounts 3

About accounts

DocuShare provides two types of accounts: individual user accounts and group accounts.
Your administrator determines who can create each type of account on your site. For
example, your site might allow a guest (someone who can view public content) to create a
user account, but require an administrator to create group accounts.

When a user account is created, either by you or an administrator, it is assigned a user
level. The user level controls the level of access to site content and functions. One or
more of the following user levels are provided when creating a user account:

* Read-Only—Allows the user to view content and manage personal content on My
DocuShare.

* DocuShare—Allows the user to access all DocuShare content management
functions.

*  CPX—Allows the user to access all DocuShare CPX content and process
management functions.

After the user account is created, the user level assigned to the account is indicated by the
superscript letters appearing after the username: read-only, DS, or CPX.

Note: If your site uses the LDAP (Lightweight Directory Access Protocol) feature to
manage user accounts, an administrator creates an account for you. To find out how your
site is configured, see your DocuShare administrator.

User Guide 3-1
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User accounts

To add and edit content, you must have a DocuShare user account.

Creating a user account

If your site allows a guest to create accounts, you can create a user account. If account
creation is restricted, an administrator will need to create a user account for you.

To create a user account:

1.
2.
3.

On the navigation bar, click Users & Groups.

Click the Add User link.

On the Add User page, enter the following information:
Username—The name to use to log into DocuShare.

Password and Password Confirm—The password to use to log into DocuShare.
Your administrator can specify that passwords adhere to a set of rules. If
specified, the rules appear on the page.

Passwords are case-sensitive and must be typed as specified when logging in.

Domain—An organization or other entity on your DocuShare site. The menu lists
internal domains only.

User Level—The level of access to site content and functions.

Last Name—The last name of the user. Users are listed on the DocuShare site by
their first and last names.

Enter any optional information. Click a field name for a description of each
property.

Note: If your administrator created custom properties, they also display on the
page. See your administrator for information about custom properties.

Click Apply.
The View Properties page for the user account appears.

If DocuShare was unable to create a new account, a message page appears
describing the problem.

User Guide



Managing accounts User accounts

Viewing user account properties

You can view the properties of any DocuShare user account.
To view a user’s account properties:

1. Locate and select the user whose properties you want to view. To search for a
user, see Finding and listing site accounts on page 3-14.

The View Properties page appears, displaying the user’s properties. Click a field
name for a description of each property.

Changing your user account properties

You must be logged in as the user whose properties you want to change. You can view,
but not change, another user’s properties.

To change your user account properties:

1. On the navigation bar, click your username.
2. On the View Properties page, click the Edit link.

3. Change the properties you want. Click a field name for a description of each
property.

4. Click Apply.

Changing your password

You must be logged in as the user whose password you want to change. You cannot
change another user’s password.

Note: If your site uses the LDAP feature, you cannot change your password. Your
administrator must change your password on the LDAP server.

To change your current password:

1. On the navigation bar, click your username.

2. On the View Properties page, click the Change Password link.
3. Enter your current password in the Old Password field.

4. Enter your new password in the New Password field.

Your administrator can specify that your password adhere to a set of rules. If
specified, the rules appear on the page.

Enter your new password in the New Password Confirm field.
6. Click Apply.

User Guide 3-3
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Changing your username

You must be logged in as the user whose username you want to change. You cannot
change another user’s username.

Note: If your site uses the LDAP feature, you cannot change your username. Your
administrator must change your username on the LDAP server.

To change your username:

On the navigation bar, click your username.
On the View Properties page, click the Change Username link.
Enter your current password in the Password field.

Enter a new username in the Username field.

o & 0D =

Click Apply.

The View Properties page appears displaying your new username. The new name
also appears on the navigation bar.

Viewing your usage quotas

Your administrator can restrict the number of documents that you own as well as the
maximum size allocated to all of your documents. You can view your quotas and your
current usage.

Note: Documents include email attachments and documents attached to discussion topics
and wiki pages.

To view your usage quotas:

1. On the navigation bar, click your username.
2. On the View Properties page, click the Quotas link.
If set, the page displays your quotas

Note: When Not set (default to highest group setting) is used, DocuShare
checks the quotas assigned to all the groups you are a member of and uses the
highest. If none of the groups have quotas set, then your quotas default to
unlimited.

3. To view your current usage, click the Show Quota Usage button.
The meters display your current usage information.

Should you exceed your usage quotas, you will receive an error message when you try to
add another document to your site. Contact your administrator should this occur.
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Changing your domain

If your site uses domains, you can change to another internal domain on DocuShare. You
must be logged in as the user whose domain you want to change; you cannot change
another user’s domain.

To change your current domain:

1. On the navigation bar, click your username.

2. On the View Properties page, click the Change Domain link.
3. Select a new domain from the Domain menu.

4. Click Apply.

Selecting a theme

Themes let you personalize the look of your DocuShare site. Four pre-defined themes are
provided; each changes the color scheme used on site pages.

To select a theme:

1. On the navigation bar, click your username.
2. On the View Properties page, click the Themes link.
3. Select a theme.
Note: If you choose to not use a theme, the default theme is used.
4. Click Apply.

Viewing your activity history

DocuShare keeps track of all user activity on your site, which provides an audit trail of the
actions of each user. You can view your site activity only. An administrator can view the
activity of all site users.

Your administrator determines whether or not the activity history feature is enabled on
your site.

To view activity history:

1. Click your username on the navigation bar.

2. On the View Properties page, click the Activity History link.

3. From the Activity menu, select the type of activity you want to view.
4

From the Object Type menu, select an object to limit the activity displayed to a
specific object type.

From the Show Last menu, select the number of activity events to display.
To display the activity during a specific date range, enter start and end dates.
7. Click Go.

User Guide 3-5



User accounts Managing accounts

Information about the activity displays. You can click Show as XML to convert the
information to Extensible Markup Language (XML) format for use with other
applications.

Changing federation settings

DocuShare federation enables you to search multiple DocuShare sites to easily access
content located on several servers. If your site is a member of a DocuShare federation (a
Federation icon appears at the bottom of a DocuShare page), you must map your user
account information to the other member servers that you want to access.

To map your user account:

1.
2.

On the navigation bar, click your username.
On the View Properties page, click the Federation Settings link.
The Federation Settings page lists the servers in your federation.

Click the Edit Mapping link that appears to the right of the server to which you
want to map.

The Edit Mapping page appears. If you know your username on the server,
continue with step 4. To search for your username, go to step 5.

Note: If you do not have an account on the server, see the procedure To create a
user account on a federated server below.

To enter your account information, click Enter manually and do the following:

a. Enter your username, password, and domain (if applicable).
b. Click Apply.
Your username appears on the Federation Settings page.

To select your user account from a list, click Choose from list and do the
following:

a. Find your account by doing one of the following:

»  Enter part of your first name, last name, or username in the Search field
and click the Go button.

» If displayed, click Show All to list all user accounts.

» Click Show users with my email address to display the accounts with
your email address.
b. Select your account.
c. Enter the password for the account.
d. Click Apply.
Your username appears on the Federation Settings page.

To create a user account on a federated server:

1.

3-6

On the Edit Mapping page, click the Create a new user account on this server
link.

The Add User page on the server on which you are creating the account appears.
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Note: If the site does not allow guest access, you cannot create an account.

Enter your account information and click Apply.

w

Click the browser’s Back button until you return to the Edit Mapping page on the
initial server.

Click Choose from list.

Display your account and select it.
Enter your password.

Click Apply.

Your username appears on the Federation Settings page.

N o o &

To remove an account mapping:

1. On the navigation bar, click your username.
2. On the View Properties page, click the Federation Settings link.
The Federation Settings page lists the servers in your federation.

3. Click the Edit Mapping link that appears to the right of the server whose mapping
you want to remove.

4. On the Edit Mapping page, click No user mapping.
5. Click Apply.

Your username does not appear next to the server on the Federation Settings
page.

Deleting a user account

Only an administrator can delete an existing user account. Contact your administrator if
you want to delete your user account. If you have several user accounts, your
administrator can combine any number of the accounts into one account.
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Group accounts

A group consists of any number of DocuShare users, groups, or both. When your site
includes groups, you can more easily manage access to objects by assigning permissions
to the group instead of to each user.

Creating a group

The DocuShare administrator can choose to allow logged-in users to create group
accounts or to have group account creation under administrative control. If after logging
into DocuShare, you do not see the Add Group link on the Users and Groups Registry
page, then an administrator will need to create a group for you.

To create a group:

1. On the navigation bar, click Users & Groups.
2. Click the Add Group link.

3. In the Title field, enter a name for the group. The name can contain spaces and
punctuation marks, and can be identical to another group name.

4. In the Domain field, select a domain name. The menu lists internal domains only.

5. Enter any optional information. Click a field name for a description of each
property.

Note: If your administrator created custom properties, they also display on the
page. See your administrator for information about custom properties.

6. Click Apply.
The Pick Members for Group page appears.

7. In the Show field, select the type of account you want to display in the Possible
Users/Groups field.

8. Do one of the following:

» To find a specific account, enter part of the user’s first name, last name, or
username or the group’s title in the Search field. Click the Go button.

« To list all accounts, click Show All (if displayed).
« To display your favorite accounts, click Show Favorites.

9. Inthe Possible Users/Groups field, select the accounts to add to the group and
click the Add button. To select multiple accounts, use the CTRL key (Windows) or
the Command key (Macintosh).

10. Inthe Selected Users/Groups field, select any accounts that you want to remove
from the group and click the Remove button. To select multiple accounts, use the
CTRL key (Windows) or the Command key (Macintosh).

11. Click Update.
The group members display on the Members page.

12. To give one or more members manage permission to the group, click the
checkbox next to each member’s name and click Apply. Manage permission
allows the member to change the group’s properties and membership.
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Viewing group properties
You can view the properties of any DocuShare group.
To view a group’s properties:
1. Locate and select the group whose properties you want to view. To search for a
group, see Finding and listing site accounts on page 3-14.

The View Properties page for the group appears. Click a field name for a
description of each property.

Changing group properties

Depending on how the group was set up, either the logged-in owner of the group or a
logged-in group member can change the properties of a group.

To change a group’s properties:

1. Locate and select the group whose properties you want to change. To search for a
group, see Finding and listing site accounts on page 3-14.
2. On the View Properties page, click the Edit link.

3. Change the properties that you want. Click a field name for a description of each
property.

4. Click Apply.

Viewing the usage quotas for a group

Your administrator can restrict the number of documents that each group member can
own as well as the maximum size allocated to all of the documents. You can view the
quotas assigned to a group.

Note: Documents include email attachments and documents attached to discussion topics
and wiki pages.

To view the usage quotas for a group:

1. Locate and select the group whose usage quotas you want to view. To search for
a group, see Finding and listing site accounts on page 3-14.

2. On the View Properties page, click the Quotas link.
If set, the page displays the quotas.

Note: Any quotas set for a user take precedence over the quotas set for a group
the user is a member of.
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Changing the members of a group

Depending on how the group was set up, either the logged-in owner of the group or a
logged-in group member can change the members of the group.

To change a group’s members:

1.

Locate and select the group whose members you want to change. To search for a
group, see Finding and listing site accounts on page 3-14.

On the View Properties page, click the Members link.
The Members page shows the current group members.
To change group members, click the Change Membership button.

In the Show field, select the type of account you want to display in the Possible
Users/Groups field.

Do one of the following:

» To find a specific account, enter part of the user’s first name, last name, or
username or the group’s title in the Search field. Click the Go button.

« To list all accounts, click Show All (if displayed).
+ To display your favorite accounts, click Show Favorites.

In the Possible Users/Groups field, select the accounts to add to the group and
click the Add button. To select multiple accounts, use the CTRL key (Windows) or
the Command key (Macintosh).

In the Selected Users/Groups field, select any accounts that you want to remove
from the group and click the Remove button. To select multiple accounts, use the
CTRL key (Windows) or the Command key (Macintosh).

Click Update.

The group members display on the Members page.
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Changing the owner of a group

Only the logged-in owner of the group can change its owner. After changing the group’s
owner to another user, you will no longer be able to change the group’s members and
properties, unless you have manage permission to the group.

To change the owner of a group:

1. Locate and select the group whose owner you want to change. To search for a
group, see Finding and listing site accounts on page 3-14.

2. On the View Properties page, click the Edit link.
3. Click Change Owner.

The Change Owner page appears.
4. Do one of the following:

» To find a specific user account, enter part of the user’s first name, last name,
or username in the Search field. Click the Go button.

« To list all user accounts, click Show All (if displayed).

« To display your favorite accounts, click Show Favorites.

Select a name from the New Owner field.
6. Inthe Add Owner to Group field, click Yes to add the new owner to the group.
7. Click Update Owner.

Changing the domain of a group

If your site uses domains, you can change a group’s domain to another internal domain on
DocuShare. You must be the logged-in owner of the group to change its domain.

Note: Changing the group’s domain does not change a group member’s domain, if one is
used.

To change a group’s domain:

1. Locate and select the group whose domain you want to change. To search for a
group, see Finding and listing site accounts on page 3—14.

2. On the View Properties page, click the Change Domain link.
Select a new domain from the Domain menu.

4. Click Apply.
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Sending mail to group members

To easily communicate with a DocuShare group, you can send an email message to the
group’s members. The message is sent to each member whose user properties include an
email address. To send email, your web browser must be correctly configured with a mail
client, such as Microsoft Outlook or Netscape Communicator.

To send email to the members of a group:

1. Locate and select the group that you want to send an email message to. To
search for a group, see Finding and listing site accounts on page 3—14.

2. On the View Properties page, click the Email link.
3. To write your message, click the here link.

Your browser launches an untitled message window with each group member’s
email address entered in the To field.

4. Compose your message and click Send to email the message to the members of
the group.

Viewing the change history

DocuShare keeps track of all the changes to site objects, which provides an audit trail of
the changes to objects.

To view the change history:

1. Locate and select the group whose change history you want to view. To search for
a group, see Finding and listing site accounts on page 3-14.

2. On the View Properties page, click the Change History link.
From the Change menu, select the type of change you want to view.
4. Do one of the following:

* Enter part of a name in the Search for User field and then choose the user
from the Select User menu.

+ If displayed, click Show All and then choose the user from the Select User
menu.

*  Choose All from the Select User menu.

From the Show Last menu, select the number of change events to display.
6. To display the activity during a specific date range, enter start and end dates.
7. Click Go.

Information about the change displays. You can click Show as XML to convert the
information to Extensible Markup Language (XML) format for use with other
applications.
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Deleting a group
You can delete a group if you are the logged-in owner of the group.
To delete a group:

1. Locate and select the group that you want to delete. To search for a group, see
Finding and listing site accounts on page 3-14.

2. On the View Properties page, click the Delete Group link.
The Confirm Delete page appears.

3. Click Delete to remove the group from your site.
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Finding and listing site accounts

From the List page, you can quickly search the users and groups registry to determine
whether or not a user or group has an account on the DocuShare site. You also can list all
of the user and group accounts registered on the site.

To search for a user or group:

1. On the navigation bar, click Users & Groups.
2. On the List page, select the type of account you want to find in the Show field.

3. When searching for a user, select a single user level or all levels from the User
Level menu.

4. In the Search field, enter any part of a username or group title.
5. Click Go.

The search results display, listing the users, groups, or both who match the search
text.

To list the accounts on your site:

1. On the List page, select the type of account you want to list in the Show field.
2. Click Show Al (if displayed).
The list of all registered accounts displays.

When displaying the list of accounts as a CPX user, the List page enables you to see
which users are logged into DocuShare. The user icon next to the user’s name indicates
whether or not the user is logged in; the icon is grayed when the user is not logged in.
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About DocuShare objects

You create content on your site by adding different types of DocuShare objects. You
organize site content in container objects called collections. Using the CPX feature, you
manage the content and resources associated with projects in objects called workspaces.
Objects that you can add to collections and workspaces include: documents, calendars,

discussions, weblogs, wikis, and URLs.

DocuShare identifies each object on your site with a unique handle (for example,
Document-37 and Calendar-102). The type and number of objects on your site are
dependent on your organization’s needs.

Each DocuShare object is indicated by an icon. Table 4—1 shows the current DocuShare

icons.

Table 4—1: DocuShare icons

DocuShare object and its icon

User—A registered DocuShare
user.

Group—One or more
DocuShare users, groups, or
both.

Collection—A container for
storing DocuShare objects.

Document—A document
stored on the DocuShare site.
The icon can vary, depending
on the document’s file type.

Workspace—A shared area for
project and team collaboration.

Content Rule—A configurable
rule for running an action after a
change occurs to a specified
object.

Wiki—A collaborative web site.

Weblog—A simple web site for
frequent postings.

Discussion—An online forum
where topics can be posted.

User Guide

Topic—A posting to a
discussion.
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Table 4—1: DocuShare icons

DocuShare object and its icon

Calendar—An online monthly
or weekly calendar.

Event—A calendar entry.

Mail Message—An email
message.

Saved Query—Saved search
query terms that can be used
for a search.

Notification—Email notification
after a change occurs to a
specified object.

URL—An Internet address for a
web page.

4-2
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Object permissions

Object permissions

Every DocuShare object has an access list, which identifies the users and groups who
have permissions to the object and the type of permission each account has. The type of
permission controls what a user can do with the object.

Depending on how your administrator set up your site, either three or six permissions are
available for use. In addition, you can control who can see an object in a search results
list. Table 4—-2 provides a description of each permission.

Table 4-2: Permissions

Three Permissions Six Permissions

Reader allows the user or group to read
the content of the object and view its
associated properties and permissions.

Read Properties allows the user or group
to view the object’s properties and
permissions.

Writer allows the user or group to change
the object’s properties and add new
objects, including new versions of
documents.

Read Content allows the user or group to
read the content of the object.

Manager allows the user or group to
delete the object, and change the object’s
permissions and owner.

Read History allows the user or group to
view the object’s change history.

Write Properties allows the user or group
to change the object’s properties.

Write Content allows the user or group to
add new objects, including new versions
of documents, and change the object,
such as its location.

Manage allows the user or group to delete
the object, and change the object’s
permissions and owner.

Appendix A, Task permissions details the type of permission required for each object task.
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Adding objects

You can add an object to your site if you are logged in and have the required permission to
the container. You can add any type of object to collections and workspaces. You can add
events to calendars and topics to discussions.

To add an object:

1.
2.

Navigate to and open the container to which you want to add an object.
From the Add menu, select the type of object that you want to add.
The Add page appears.

In the Title field, enter a name for the object. The name should be short, but
descriptive, and can contain spaces and punctuation marks.

Enter any additional required information as well as optional information. Click a
field name for a description of each property.

Note: If your administrator created custom properties, they also display on the
page. See your administrator for information about custom properties.

Click Apply.
The object is added to the container.

For more information on adding documents, see Adding a document on page 5-2.
For more information on adding discussions, weblogs, and wikis, see Using social
computing features.
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Viewing objects in containers

When viewing objects in a collection or events in a calendar, you can change how the
objects are displayed in the container. In addition, you can control the number of objects to
display per page.

You can display a collection in any of the following views:

List view—Displays objects in a list.

Images view—Displays image files as thumbnails and all other object types as
large icons.

Email view—Displays the properties associated with email messages.

You can display a calendar in any of the following views:

Month view—Displays an entire month with the current day highlighted. From the
current month, you can click a link for the previous month and the next month. You
can also display calendars for previous and following years.

The start time and title of each calendar event is shown on the date to which it
was added.

Week view—Displays an entire week with the current day highlighted. From the
current week, you can click a link for the previous week and the next week. You
can also display calendars for previous and following years.

The duration, title, and owner of each event is shown on the date to which it was
added.

Day view—Displays the current day. From the current day, you can click a link for
the previous day and the next day. You can also display a day from another month
or year.

The day view shows the duration, title, and owner of each event added to the
date.

To set the number of objects to display per page:

On the navigation bar, click your username.
On the View Properties page, click the Edit link.

In the Page Size field, enter the number of objects you want to view on pages with
object listings (for example, collections and search results).

Click Apply.
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Viewing and changing object properties

Every object has a set of assigned properties. For example, the properties for all objects
include a title, a description, and an owner. Each object has a number of specific
properties. For example, the sort order property is unique to collections and documents
have a maximum versions property. Your DocuShare administrator also can create
custom properties for use at your site. You can assign property values to objects, which
allows you to categorize objects, provide information about objects to other users, and
facilitate searches.

To view and change the properties of an object:

1. Locate the object whose properties you want to view and change.
2. Click the object’s Properties icon.

3. On the View Properties page, click the Edit link.

4

Change the properties you want. Click a field name for a description of each
property.

Note: If your administrator created custom properties, they also display on the
page. See your administrator for information about custom properties.

5. Click Apply.

Viewing the change history

DocuShare keeps track of all the changes to site objects, which provides an audit trail of
the changes to objects. Your administrator determines whether or not the change history
feature is enabled on your site.

To view the change history:

Locate the object whose change history you want to view.
Click the object’'s Properties icon.
On the View Properties page, click the Change History link.

From the Change menu, select the type of change you want to view.

o B w0 D=

Do one of the following:

* Enter part of a name in the Search for User field and then choose the user
from the Select User menu.

* Click Show All (if displayed) and then choose the user from the Select User
menu.

* Choose All from the Select User menu.
6. From the Show Last menu, select the number of change events to display.
7. To display the activity during a specific date range, enter start and end dates.
8. Click Go.

Information about the change displays. You can click Show as XML to convert the
information to Extensible Markup Language (XML) format for use with other
applications.
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Managing access to objects

When you add an object to your site, you set the object’s initial permissions. As the user
who added the object, you are its owner and have full permission to it. As needed, you can
change the users and groups in the access list and the type of permissions each user or
group has.

Depending on how your administrator set up your site and if you are a CPX user, colored
key icons may appear next to objects indicating who in addition to the owner can access
the objects. You can click the key icon next to an object to display its Permissions page.

Table 4-3: Permission icons

Permission icon and its description

Green key—Indicates that the object can be accessed by all users, all groups,
E% and the administrator.

Yellow key—Indicates that the object can be accessed by all groups and the
administrator.

Red key—Indicates that the object can be accessed by the administrator only.

a

Viewing the access list of an object

To view an object’s access list:

1. Locate the object whose access list you want to view.
2. From the object’s More Actions menu, select Permissions.

The Permissions page displays the users and groups in the access list and the
permissions each account is assigned.
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Changing the access list of an object

To change an object’s access list:

1.
2.

10.

1.

Locate the object whose access list you want to change.

Do one of the following:

* From the object’'s More Actions menu, select Permissions.

+ If displayed, click the key icon that appears to the right of the object’s title.
The Permissions page for the object appears.

For Search Available To, do one of the following:

+ Click Anyone to allow guests and users to view the object in a search results
list.

* Click Access List Only to allow only those accounts in the object’s access list
that have at least Reader or Read Properties permission to see the objectin a
search results list.

If you want to change the list of users and groups who have access to the object,
click the Change Access List button.

The Change Access List page appears.

In the Show field, select the type of account you want to display in the Possible
Users/Groups field.

Do one of the following:

« To find a specific account, enter part of the user’s first name, last name, or
username or the group’s title in the Search field. Click the Go button.

+ To list all accounts, click Show All (if displayed).
+ To display your favorite accounts, click Show Favorites.

In the Possible Users/Groups field, select the accounts to add to the access list
and click the Add button. To select multiple accounts, use the CTRL key
(Windows) or the Command key (Macintosh).

In the Selected Users/Groups field, select any accounts that you want to remove
from the access list and click the Remove button. To select multiple accounts, use
the CTRL key (Windows) or the Command key (Macintosh).

Click Update Access List.
The Permissions page appears, displaying the new access list.

Check the permission boxes you want for each user and group displayed in the
access list.

Click Apply.

Note: When you change the access list and permissions of an object, the change occurs
in the background. A link to your background jobs appears under the navigation bar; you
can click the link to check the status of and delete background jobs.

Changing the owner of an object

The default owner of an object is the user who initially created the object.
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To change the owner of an object:

1.
2.

Locate the object whose owner you want to change.
Do one of the following:

»  Click the checkbox that appears to the left of the object’s title. From the Edit
Selected menu, select Change Owner. On the confirmation page, click
Confirm.

+  From the object’'s More Actions menu, select Permissions. On the
Permissions page, click the Change Owner button.

The Change Owner page appears.
Do one of the following:

» To find a specific user account, enter part of the user’s first name, last name,
or username in the Search field. Click the Go button.

» Tolist all accounts, click Show All (if displayed).
» To display your favorite user accounts, click Show Favorites.
Select a username from the New Owner field.

If the object is a document, choose how to apply the new owner to the document
and its versions.

If the object is a collection, choose how to apply the new owner to the collection
and its content.

Click Update Owner.

The Permissions page for the object appears, displaying the name of the new
owner at the top of the access list. The new owner has full permissions.

The name of the previous owner remains in the access list.
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Applying permissions to the objects in a container

When you change the permissions of a container that includes objects, you can choose
how to apply the container’s permissions to its contents. You can choose to apply all of the
permissions or only the changed permissions to either the container or the container and
its contents.

To apply a container’s permissions to the objects in it:

1. Locate the container whose permissions you want to change.
2. From the container’s More Actions menu, select Permissions.
The Permissions page for the container appears.
Make the changes you want to the access list.
4. For Options, select one of the following:
« Apply all permissions to—Assigns all of the access permissions.
* Apply only changes to—Assigns only the changed access permissions.
5. Select one of the following:

* This container only—Applies the permissions to the container only. The
permissions of the container’s objects are not changed.

« This container and its objects, including same objects that appear in
other containers—Applies the permissions to the container and the objects
in it. The permissions of the same objects that appear in other containers also
are changed.

« This container and its objects, excluding same objects that appear in
other containers—Applies the permissions to the container and the objects
in it. The permissions of the same objects that appear in other containers are
not changed.

6. Click Apply.
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Applying permissions to a document and its
versions

Each version of a document has its own access list. Therefore, when you change a
document’s permissions you can choose how you want to apply the changes to the
document’s versions.

To apply a document’s permissions to its versions:

1.
2.

Locate the document whose permissions you want to change.
From the document’s More Actions menu, select Permissions.
The Permissions page for the document appears.

Make the changes you want to the access list.

For Apply all permissions to, select one of the following:

+ This document and its versions—Assigns the changed permissions to the
document and all of its versions.

* This document only—Assigns the changed permissions to the document
only. The document and its versions will have different access permissions.

Click Apply.
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Changing the location of objects

You can move an object to another container or have the object appear in several
containers on your site. Although an object can appear in several containers, there is only
one copy of it, which saves space on your DocuShare site.

Note: You can also use the Copy, Cut, and Paste commands from the Edit Selected
menu to change the location of a collection. See Using Copy, Cut, and Paste to change
the location of an object on page 4—13.

To change the location of an object:

1.
2.

Locate the object whose location you want to change.
Do one of the following:

»  Click the checkbox that appears next to the object’s title. From the Edit
Selected menu, select Change Location. On the Confirm Change Location
page, click Confirm.

» Click the Properties icon that appears to the right of the object’s title. On the
Properties page for the object, click the Locations link.

The Change Location page appears.

In the Sort By field, select Title to display the possible containers in alphabetical
order or select Handle to display the possible containers in numerical order.

Do one of the following:

» To find specific containers, enter any part of a container title in the Search
field. Click the Go button.

+ To list all containers, click Show All (if displayed).
» To display your favorite containers, click Show Favorites.

In the Possible Locations field, select the container(s) in which you want the
object to appear and click the Add button. To select multiple containers, use the
CTRL key (Windows) or the Command key (Macintosh).

In the Selected Locations field, select any containers in which you do not want
the object to appear and click the Remove button. To select multiple containers,
use the CTRL key (Windows) or the Command key (Macintosh).

Note: Make sure at least one container appears in the Selected Locations field.
Otherwise, the object will become orphaned, which means it will not appear in any
container.

Click Update Locations.
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Using Copy, Cut, and Paste to change the location
of an object

To copy or cut objects:

1.
2.

Locate the object that you want to copy or cut.

Click the checkbox next to the object.

From the Edit Selected menu, select either Copy or Cut.
A confirm window appears.

Choose whether or not to remove any objects from the clipboard before the copy
or cut.

Click Confirm.

Note: When using the Cut command, the object title is faint until you Paste it to
another container.

Open the container in which you want to paste the object.

Note: To paste a workspace, open the workspace in which you want to paste the
object and then click Content Map.

From the Edit Selected menu, select Paste.

A confirm window appears.

Choose whether or not to remove any objects from the clipboard after the paste.
Click Confirm.

The object appears in the container.
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Editing multiple objects in a collection

When viewing an open collection, you can use the Edit Selected menu to perform a
variety of tasks on one or more objects. The menu includes these commands:

+ Add to Favorites—Add the object to Favorites on My DocuShare.

+ Archive and Restore—Move the object to and retrieve the object from an Archive
Server (commands appear if your site uses an Archive Server). See Archiving
content for more information.

* Change Location—Add the object to another location.
* Change Owner—Change the owner of the object.

+ Copy—Copy a reference of the object to the clipboard. The clipboard can contain
a maximum of 100 objects.

¢ Copy Shortcuts—Copy a reference of the object to the clipboard so it can be
pasted to a shortcuts portlet on a workspace.

+  Cut—Cut the object to the clipboard. The clipboard can contain a maximum of
100 objects.

+ Paste—Paste the object from the clipboard (command appears when an object
has been copied or cut to the clipboard).

+ Delete—Remove the object from your site.
* Rename—Change the title of the object.

* Route—Send the document to users for approval, review, or information. See
Automating work processes for more information.

To edit multiple collection objects:

1. Navigate to and open the collection.
2. Do one of the following:
» To edit some of the objects, click the checkbox next to the objects you want.

» To edit all of the objects, click the checkbox to the left of the Type column
heading.

3. From the Edit Selected menu, select the command you want.
A confirm window appears.

4. Click Confirm to continue. Depending on which command you selected,
additional pages may appear.

Note: When using the Change Location command, if an object appears in more than one
collection, only the current collection is listed in the Selected Locations field.
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Deleting objects

DocuShare provides both a site-wide trashcan and a personal trashcan for each user.
Your administrator determines which trashcans are used on your site. If your site uses
both the site-wide trashcan and personal trashcans, your trashcan appears on your My
DocuShare page. When you delete an object, it goes to your personal trashcan. You can
restore and expunge an object from your personal trashcan as long as your administrator
has not expunged the object from the site-wide trashcan. See Using your personal home
page for more information.

If your site uses the site-wide trashcan only, then objects you delete go to it. To restore an
object from the site-wide trashcan, you need to contact your administrator. If trashcans are
not used on your site, deleted objects are expunged immediately.

To delete an object:

1. Locate the object that you want to delete.
2. Do one of the following:

*  Click the checkbox that appears next to the object’s title. From the Edit
Selected menu, select Delete.

* From the object’s More Actions menu, select Delete.
The Confirm Delete page appears.

Note: If a minus sign appears in the checkbox that precedes the object, then you
do not have manage permission to the object and cannot delete it.

3. Ifyou are deleting a collection, select one of the following from the For
collections, delete menu:

* Collection and Contents to delete the collection and all of the objects in it.
+ Collection Only to delete the collection, but not its contents.

Note: If you delete a collection, but not its contents, and the objects are not
located in another collection, they become orphaned. You are unable to access
orphaned objects from a collection. Your administrator can relocate orphaned
objects in a collection so you can access them again.

4. Click Delete to remove the object from your site.
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About documents

Using DocuShare, you can store, access, and manage documents created in a variety of
popular formats. You add documents to DocuShare by uploading documents from your
computer or a network drive or by scanning paper documents. With the documents stored
on DocuShare, users connected to the network can use their browser to search for, view,
edit, and download a document.

For document management, DocuShare supports version control and document locking.
By default, DocuShare saves four versions of a document; you can change the number of
versions DocuShare saves on a per-document basis. In addition, you can change a
document’s preferred version, which is the version that opens when users view, edit, and
route the document. By default, a document’s preferred version is its latest version.
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Adding a document

You add a document to a collection or workspace to make it available to others for viewing
or collaborative work. When adding a document by uploading a document now, the
document is added immediately to DocuShare. When adding a document by scanning a
document or uploading a document later, a placeholder document is added. The
placeholder does not contain any content; you add content to the placeholder by scanning
a document using a cover sheet or by uploading a new version.

To add a document:

1.
2.

Navigate to and open the container to which you want to add the document.
From the Add menu, select Document.

The Add Document page appears.

In the Add Document By field, select one of the following:

* Uploading a document now to upload a document immediately.

+ Scanning a document using a cover sheet to scan a paper document. This
option appears if scanning is set up on your site.

* Uploading a document later to upload a document at a later time.

If you are uploading a document now, enter the complete path and filename of the
document in the Filename field or click the Browse button to navigate to and
select the document.

If you enter the path and filename of a document that does not appear on the
drive, DocuShare uploads an empty document.

Enter the following information:

Title—The title of the document. The title can contain spaces and punctuation
marks.

Max Versions—The maximum number of versions to save. When a new version
of a document is saved to DocuShare, the oldest version is deleted, unless it is
the preferred version.

Enter any optional information. Click a field name for a description of each
property.

Click Apply.

If you are uploading a document, it is added to the container. If you are scanning a
document, a cover sheet appears. Print the cover sheet. For information on how
to use the cover sheet, see Scanning documents using scan cover sheets on
page 5-14. If you are uploading a document later, you can add the document
content by adding a new version. See Adding a new document version on page
5-6.

If you chose to route the document, a Routing Slip appears. For information on
how to use the Routing Slip, see Managing access to objects on page 4-7.
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Viewing a document

When opening a document to view it, you choose to either open or save (download) the
document. The download copies the document and keeps the original document on
DocuShare.

Your browser controls how a document is displayed. By design, browsers are able to
handle several types of documents and files, such as HTML, GIF, and JPEG. However, for
some documents, such as Microsoft Word and Excel, your browser launches a helper
application (viewer) to run or display the document either outside or within the browser
window. To play multimedia files, the browser uses a plug-in, which opens the file within
the browser window.

Your browser is preconfigured to use specific helper applications and plug-ins. Generally,
if you try to open a document or file that your browser does not recognize, it displays a
window that guides you in finding the application to use for that type of file.

To view a document:

1. Locate the document that you want to view.
2. Click the document's title.
A window appears allowing you to open or download the document.

3. To return to the container page after opening the document, do one of the
following:

» If the document opened in a separate window, select Exit from the File menu.

+ If the document opened within the browser window, click the browser’s Back
button.

Note: If you click the X in the top-right corner of the browser or select Close from the File
menu, your browser closes and you lose your connection to the DocuShare site.

Viewing a document and its properties

For PDF documents, a variety of image documents (GIF, JPEG, PNG, TIFF), and other
document formats, you can view the document content while viewing and editing the
document’s properties.

Note: To view Microsoft Word and PowerPoint documents, you should use Internet
Explorer. Also, make sure your Folder Options are configured to open each document
type within the same browser window.

To view a document and its properties:

1. Locate the document that you want to view.

2. From the document’s More Actions menu, select View Document & Properties.
Both the document and its properties display in a separate window.
Change any of the properties and click Update.

4. Click Close to close the window.

User Guide 5-3



Viewing a document Working with documents

Viewing an HTML rendition of a document

DocuShare provides an HTML conversion feature that lets you view supported document
types in HTML format. This feature eliminates the need to configure your browser to
display certain document types.

Note: The HTML conversion feature cannot convert documents that contain encrypted
information.

To view an HTML rendition of a document:
1. Locate the document that you want to view.
2. From the document’s More Actions menu, select View in HTML.

DocuShare converts the document to HTML and displays the document.

3. Click the browser’s Back button to return to the container page.

Viewing a PDF rendition of a document

DocuShare provides a PDF conversion feature that lets you view supported document
types in PDF format. This feature eliminates the need to configure your browser to display
certain document types.

Note: The PDF conversion feature cannot convert documents that contain encrypted
information. You must have Adobe® Reader® installed on your computer.

To view a PDF rendition of a document:

1. Locate the document that you want to view.
2. From the document’s More Actions menu, select View in PDF.

DocuShare converts the document to PDF and displays the document.
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Adding a new document version

There are two ways to add a new document version:

»  Check out and edit an existing document, and check in the revised document as a
new version.

» Upload a document as a new version of an existing document.

Editing a document

DocuShare supports the complete development cycle of a document, allowing users to
collaborate on a project. Document check out and locking ensures that only one user at a
time edits a document. Version control maintains a user-specified number of document
versions.

To edit a document and create a new version, you must be either the logged-in owner of
the document or a logged-in user with the appropriate permission to it. In addition, the
document’s Add Versions property must be set to Allowed (default setting).

Note: If the DocuShare Client is installed on your computer and you enabled the Handle
checkout from web browser property in the DocuShare Client Properties window, the
DocuShare Client Checkin Wizard displays after you edit and save the document. When
using this feature, make sure DocuShare’s URL in the browser is the same as the server’s
address in the DocuShare Client. To check the server’s address, right-click the server
name and select Properties.

To edit a document:

1. Locate the document that you want to edit.

2. Click the document’s Check Out icon.
A window appears allowing you to open or download the document.
Edit the document.

4. Do one of the following:

« If the document opened in the browser, click the Back button. Click Yes to
save your edits.

» If the document opened in its native editor, select Save As from the File
menu.

5. Inthe Save As window, save the document to a location on your local drive.
Do not change the name of the document.

6. On the container page, click the document’s Upload a New Version icon.
The Add Version page appears.
Click the Browse button.

8. Navigate to the location on your local drive in which you saved the edited
document, select it, and click Open.

The path to the document appears in the Filename field.
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10.
11.

12.

13.

In the Title field, you can change the document title. By default, the new version is
assigned the original document title.

Optionally, enter any comments in the Version Comments field.

If you locked the document, choose whether or not you want to unlock the
document after adding the new version in the Unlock Document field.

When a document version other than the latest is the preferred version, you can
click Yes in the Make This The Preferred Version field to set this version as the
preferred one. Otherwise, click No to not change the preferred version.

Click Apply.

Uploading a new version of a document

You can add a new version of a document by uploading a document from a folder on your
local drive or a network drive.

To add a new version of a document:

1.
2.

5-6

Locate the document that you want to update with a new version.
Click the document’s Upload a New Version icon.

The Add Version page appears.

Click the Browse button.

Navigate to the location that contains the document you want to add as a new
version, select it, and click Open.

The path to the document appears in the Filename field.

In the Title field, you can change the document title. By default, the new version is
assigned the original document title.

Optionally, enter any comments in the Version Comments field.

If the previous version of the document was locked, the Unlock Document field
appears. Click No if you do not want to unlock the document after adding the new
version.

When a document version other than the latest is the preferred version, you can
click Yes in the Make This The Preferred Version field to set this version as the
preferred one. Otherwise, click No to not change the preferred version.

Click Apply.
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Managing document versions

DocuShare’s version control feature enables you to maintain a record of a document's
history. For each version DocuShare saves, you can view the content, the date and time
the version was added, the user who added the version, and any user-provided comment.
You can also view and edit each version’s properties and permissions, and route individual
versions.

By default, DocuShare saves four versions of a document. You can change the default
setting by changing the document's Max Versions property.

Viewing document versions

To view a document’s version history:

1. Locate the document whose version history you want to view.
2. Click the document’s Properties icon.
The View Properties page appears.
3. Click the Version History link.
The page displays all saved versions of the document.
4. To view a specific version of the document, click its type or version number.
To return to the Version History page, do one of the following:
« If the document opened in a separate window, select Exit from the File menu.

+ If the document opened within the browser window, click the browser’s Back
button.

Changing the preferred version

By default, a document’s preferred version is the latest version. When there is more than
one version of a document, you can change the document’s preferred version. This is the
version of the document that opens when users view, edit, and route the document.
However, users can route a specific document version from the document’s Version
History page.

DocuShare always saves the preferred version, regardless of the number of Max
Versions specified.

To change a document’s preferred version:

1. Display a document’s Version History page.
2. Click Change Preferred Version.

Radio buttons display next to each version and the Use Latest Version option
appears.
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3. Do one of the following:

» To select one of the existing versions as the preferred version, click the radio
button next to the version you want.

+ To always have the latest version of the document be the preferred version,
click the radio button next to Use Latest Version.

4. Click Apply.

Viewing the renditions of a version

Each version of a document can consist of a number of renditions. A rendition is the
version’s display format, such as Microsoft Word, Adobe PDF, or HTML, and can be
comprised of content files. For example, an HTML rendition of a particular document
version would consist of the HTML file and several image files if the rendition contained
graphics.

To view a version’s renditions:

1. Display a document’s Version History page.
2. To view the version renditions, click Show Renditions.

The version renditions display and, if a rendition contains content files, those files
display.

You can click a rendition or a content file to view it.

4. Click Hide Renditions to not view the renditions.

Viewing and changing version properties
To view and change a version’s properties:

1. Display a document’s Version History page.
2. Click the document version’s Properties icon.
The View Properties page appears.
Click the Edit link.

4. Change the properties you want. Click a field name for a description of each
property.

5. Click Apply.
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Locking and unlocking a document

You can lock a document when you want to keep other users from editing it. To allow users
to edit a locked document, you need to unlock the document. To unlock a document, you
must be the logged-in user who locked the document. A document is locked if a Lock icon
appears to the left of the document’s title.

To lock a document:

1. Locate the document that you want to lock.
2. From the document’s More Actions menu, select Lock.

A Lock icon appears to the left of the document title. Users can view the
document, but they cannot edit it.

To unlock a locked document:

1. Locate the document that you want to unlock.
2. From the document’s More Actions menu, select Unlock.

A Lock icon no longer appears to the left of the document’s title. Users can now
edit the document.

User Guide 5-9



Finding duplicate documents Working with documents

Finding duplicate documents

DocuShare provides a finder feature that enables you to find documents with identical
content, regardless of their format. Before you can use this feature, your administrator
must enable it.

To find duplicate documents:

1. Locate the document that you want to check for duplicates.
2. From the document’s More Actions menu, select Find Duplicates.

Any documents with the same content display.
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Exporting documents

Your administrator can set up locations on external servers to which you can export
documents. You can export a single document or several documents at a time.

To export a document:

1. Locate the document that you want to export.

2. Click the checkbox that appears next to the document’s title.

3. From the Edit Selected menu, select Export Document.
The Confirm Export Document page appears.

4. Inthe Location field, select the external location for the document.
Click the Confirm button.

User Guide 5-11



Adding comments to a document Working with documents

Adding comments to a document

You can post comments on a document to maintain an informal commentary on it. For
instance, when co-authoring a document, you can add helpful comments for the other
document authors.

To post a comment on a document:

1.
2.
3.

Locate the document on which you want to post a comment.

Click the document’'s Comments icon.

If the are current comments on the document, click the Add a comment link.
The Add Comments page appears.

In the Title field, enter a name for the comment.

In the Description field, enter the comment text.

Click Apply.

You can view the comments on a document by clicking its Comments icon. To
edit a comment, click the comment’s Edit icon.
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Scanning documents

You can add documents to your DocuShare site by scanning them. DocuShare provides
two methods for scanning documents:

* You can use a scan cover sheet to scan documents to specific locations and as
new document versions. At a multifunction device, you scan a cover sheet with a
document to convert it to PDF format and add the digital document to DocuShare
as specified in the cover sheet.

Note: The scan cover sheet feature has been optimized for use with Xerox
multifunction devices. Therefore, the feature does not support all non-Xerox
multifunction devices and software. In addition, DocuShare currently supports
image-only file formats when scanning (TIFF, non-searchable PDF, etc.).
Searchable PDF file formats are not supported for use with scan cover sheets.

* You can scan documents to a temporary scan collection that your administrator
sets up on your site. Using a WorkCentre with the Scan to File feature, you scan a
document to convert it to TIFF format and add the digital document to the
temporary scan collection. You then save the scanned document to a permanent
collection on your site.

Your administrator determines which method you can use for scanning documents.
Therefore, check with your administrator to find out how your site is set up.

Scanning documents using scan cover sheets

You can scan documents to specific locations and as new document versions using scan
cover sheets. You can create scan cover sheets for these types of objects:

* documents—to scan a document as a new document version

* collections—to scan a document to a collection

* workspaces—to scan a document to the content portlet of a workspace
» user—to scan a document to your personal collection

A scan cover sheet includes a DataGlyph, which encodes machine-readable information
about the scan location and the cover sheet owner. You place the cover sheet on top of a
document and scan both to add the resulting PDF document to DocuShare.

In addition, you can choose to create a cover sheet for a document when using the Add
Document page to upload a document. For more information, see Adding a document on
page 5-2.

Creating a scan cover sheet

To create a scan cover sheet:

1. Do one of the following:

» To create a cover sheet for a document, collection, or workspace, locate the
object. Then click the object’s Properties icon.

» To create a cover sheet for your personal collection, click your username on
the navigation bar.
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2. On the View Properties page, click the Scan Cover Sheet link.
3. Click the Create Scan Cover Sheet link.

The cover sheet is created and opens in a separate window.
4. Print the cover sheet. Then close it.

The Scan Cover Sheet page lists the cover sheet and provides the date and time
at which it was created.

Scanning a document with a scan cover sheet

If you have access to a multifunction device that supports Scan to File, you can scan a
cover sheet with a document to add a PDF version of the document to DocuShare.

Note: Since the user interface for multifunction devices can vary, the following procedure
provides general steps for scanning a document to DocuShare.

To scan a document:

1. Put the cover sheet on top of a document and place the pages in the document
feeder.

2. Display the scan to file screen.
Follow any instructions specific to the type of device.
4. Press the Start button.

The device scans the document and then adds it to DocuShare as specified in the
cover sheet.

Deleting a scan cover sheet

When you no longer want a cover sheet to be used to scan a document, you can delete it.
Deleting the cover sheet invalidates any printed copies of it. You might want to delete a
cover sheet if you misplace it and do not want anyone else to use the cover sheet.

To delete a scan cover sheet:

1. Locate the object whose cover sheet you want to delete

2. Click the object’'s Properties icon.

3. On the View Properties page, click the Scan Cover Sheet link.
4

Click the Trashcan icon that appears to the right of the cover sheet.
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Scanning documents to a temporary scan collection

If you have access to a WorkCentre with the Scan to File feature enabled, you can scan
documents to DocuShare. Your WorkCentre administrator must set up a scan template
before you can scan documents to DocuShare. When setting up a scan template, the
administrator can choose to save each document page to a TIFF file or to save all of the
document pages to a single TIFF file. Also, you may be able to use a scan template to
enter DocuShare property values at the device, before scanning the document. After the
document is scanned to a collection, the values you entered appear on the View
Properties page for the document.

Before you begin, check with your administrator to find out which templates are available
for your use and whether or not a password is required.

Note: Depending on which WorkCentre model you use, the steps for scanning a
document can vary. DocuShare does not support scanning color images on a WorkCentre
Pro 40 using JPEG compression (JPEG-in-TIFF).

To scan a document:

Place a document on the document glass or in the document feeder.
Press the Features button.

On the touch screen, press the Scan tab.

Press Scan to File.

Select the scan template.

2B

If the template requires a password, do the following:

Press Added Features.

Press Filing Setups.

Press Login Name/Password.
Press Password.

Type your password and press Save.
Press Save.

~ 0o 000w

7. If the template allows you to specify property values, enter values for the ones you
want.

8. Press the Start button.

The WorkCentre scans the document and then sends it to the temporary scan collection
on your DocuShare site. The document is stored in this collection for a designated time
period. You can check the time period by clicking WorkCentre Scan Repository on the
DocuShare home page. To keep the document, you need to save it to a permanent
collection.
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Saving a scanned document to a collection

To save a scanned document to a collection:

1.
2.
3.

10.

11.

12.
13.
14.

15.

Go to the DocuShare home page.
Click WorkCentre Scan Repository.

If the Passcode field appears, enter the password you entered at the WorkCentre
to scan the document and then click Enter Passcode.

Locate your scanned document.
Click Save.

If you do not want to save the document to a collection, click Delete to remove the
document from the temporary scan repository.

If you want to rotate the document, select the number of degrees from the Rotate
Image menu and click Go.

From the Document Type menu, select the type of document to save the
scanned document as.

The menu contains types in addition to Document if your administrator created
custom documents on your site.

If your administrator specified a default collection in which to save scanned
documents, its title appears in the Destination field. Do one of the following:

* If you want to use the default collection, go to step 13.

+ If you want to change the collection, click Select. The Select Destination page
appears.

In the Sort By field, select Title to display the collections in alphabetical order or
select Handle to display the collections in numerical order.

Do one of the following:

+ To find specific collections, enter any part of a collection title in the Search
field. Click the Go button.

» To list all collections, click Show All (if displayed).
» To display your favorite collections, click Show Favorites.
» To display your personal collection, click Show Personal Collection.

In the Possible Locations field, select the collection to which you want to save
the document.

Click Apply.
In the Title field, enter a title for the document.

Enter any additional information. Click a field name for a description of each
property.

Click Save.

The document is saved to the collection you specified.

Note: Your administrator may have given you access to a collection named Temporary
Scan Repository. Alternatively, you can open this collection to move or delete your
scanned document.
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About notifications

A notification allows you to receive an email message when a change occurs to an object.
You can add a notification for any object on your site. For example, you can add a
notification for a document to have DocuShare email you when a new version of the
document is uploaded. You might want to add a notification for a collection to know when
new content is added to the collection.

To use notifications, your administrator must enable and set up the feature. In addition,
your user account properties must include an email address.

You can add a notification for any of the following changes to an object:

Any change—Any change to the object.

Something added—A new object is added to a container.

New document version added—A new version of a document is added.
Something deleted—An object is deleted from a container.

Properties edited—The properties of the object are changed.

Permissions edited—The permissions of the object are changed.

Change in ownership—The owner of the object is changed.

Location edited—The location of the object is changed.

Document locked or checked out—The document is locked or checked out.

Document unlocked—The document is unlocked after being locked, but a new version of
it was not added.

Note: DocuShare offers feeds to site collections and other types of containers. If you are
using a browser with built-in feed support or you have a feed reader installed on your
computer, you can add a feed to a DocuShare container. This enables you to view
updated content in the container, provided you have the necessary permissions, without
having to go to the DocuShare site in your browser.
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Adding a notification

You can quickly add a simple notification to have DocuShare email you when new content
is added to an object, or you can choose advanced options to customize the notification.

To add a notification:

1.
2.

6.

Locate the object for which you want to add a notification.

Do one of the following:

» Click the object’s Notifications icon.

« Click the object’s Properties icon. Then click the Notifications link.
On the Notifications page, click Create a New Notification.

In the Period field, select one of the following time periods:

+ Immediate provides notification immediately after the event occurs.
« Daily provides notification in a daily summary report.

*  Weekly provides notification in a weekly summary report.

To select advanced options, click Show Advanced Options and choose from the
following:

Events of Interest—The event or events of which you want to be notified. To
select multiple events, use the CTRL key (Windows) or the Command key
(Macintosh).

Include Recipient Activity—Specifies whether or not to also notify the user
whose action caused the notification. Select Yes to notify the user; otherwise,
select No.

External Recipients—The email addresses for recipients who are not registered
users on the DocuShare site. Separate email addresses with a comma. This field
is optional.

Sender—The username that appears in the email message From field: Admin or
Owner.

Notification Applies To—If the object is a collection or a workspace, specifies
how to apply the notification to the collection and the objects in it.

Initial Permissions—Specifies the permissions for the notification.

Note: If you are an administrator, additional fields appear enabling you to have a
script run when an event of interest occurs. Before entering information in the
fields, you must create a script and place it in the extension folder of your
DocuShare directory. In the Script field, enter the name of the script that you want
to run when the event of interest occurs. In the Script Data field, enter any string
values that you want to pass to the script when it is called.

Click Apply.

Note: If you are receiving too many email messages from notifications, you can choose to
not receive messages for one or more types of events for all of your notifications. Click
your username on the navigation bar and use the Suppress Notification Messages
menu on the Edit page to turn off the events you want.
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Viewing notifications

You can easily view the notifications added for an object as well as the notifications you
own for site objects.

To view an object’s natifications:

1. Locate the object whose notifications you want to view.
2. Do one of the following:
« Click the object’s Notifications icon.
+ Click the object’s Properties icon. Then click the Notifications link.

The object’s current notifications display.

To view your notifications:

1. On the navigation bar, click your username.
2. On the View Properties page, scroll to locate the Subscribed To property.

The notifications you added for objects display in the field. You can click a
notification to view its properties.
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Creating a recipient list for a notification

You can create a recipient list for a notification to have DocuShare notify others when a
change occurs to an object. For example, you may want co-workers to know when a new
version of a document is uploaded or when an object is moved to another location.

To create a recipient list for a notification:

1.

10.

Locate the object that has the notification for which you want to create a recipient
list.

Do one of the following:

« Click the object’s Notifications icon.

« Click the object’s Properties icon. Then click the Notifications link.
The object’s current notifications display.

Click the Properties icon that appears to the right of the notification you want to
change.

The View Properties page appears.
Click the Recipients link.
Click Change Recipients.

In the Show field, select the type of account you want to display in the Possible
Users/Groups field.

Do one of the following:

» To find a specific account, enter part of the user’s first name, last name, or
username or the group’s title in the Search field. Click the Go button.

« To list all accounts, click Show All (if displayed).
« To display your favorite accounts, click Show Favorites.

In the Possible Users/Groups field, select the accounts to add to the recipient list
and click the Add button. To select multiple accounts, use the CTRL key
(Windows) or the Command key (Macintosh).

In the Selected Users/Groups field, select any accounts that you want to remove
from the recipient list and click the Remove button. To select multiple accounts,
use the CTRL key (Windows) or the Command key (Macintosh).

Click Update.
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Viewing and changing notification properties

When you add a notification, a default name is assigned to it. You may want to change the
name to something more descriptive as well as change other properties.

To view and change an object’s notification properties:

1.
2.

Locate the object whose notification properties you want to view and change.
Do one of the following:

+ Click the object’s Notifications icon.

+ Click the object’s Properties icon. Then click the Notifications link.

The object’s current notifications display.

Click the Properties icon that appears to the right of the notification you want to
change.

The View Properties page appears.
Click the Edit link.

Change the properties you want. Click a field name for a description of each
property.

Click Apply.
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Deleting a notification

Depending on how your site is set up, a deleted notification can go to either your personal
trashcan on My DocuShare or the site-wide trashcan. Contact your administrator to find
out which trashcans are used on your site. If you have a personal trashcan, you can
restore an object from it as long as your administrator has not expunged the object from
the site-wide trashcan. See Using your personal home page for more information.

To delete a notification:

1. Locate the object whose notification you want to delete.

2. Do one of the following:
« Click the object’s Notifications icon.
+ Click the object’s Properties icon. Then click the Notifications link.
The object’s current notifications display.

3. Click the Properties icon that appears to the right of the notification you want to
delete.

The View Properties page appears.
4. Click the Delete icon.

The Confirm Delete page appears.
5. Click Delete.
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About workspaces

A workspace provides a shared area for project and team collaboration. From a single
page within DocuShare you and other workspace members can gather and manage
shared content, access collaboration tools to facilitate your work, and communicate with
each other.

A workspace consists of four distinct areas called portlets; each portlet has a different use.

+ Content portlet—The area in which you add and manage shared content.
+ Shortcuts portlet—Displays frequently used objects.
+ Calendar portlet—Shows a combination of the calendars in the content portlet.

* Membership portlet—Lists the users who are members of the workspace
membership group.

You can close a portlet and reopen it by clicking the small triangle next to the portlet title.
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Adding a workspace

You can add a workspace to another workspace or you add a workspace to My
DocuShare. To guide you in creating a workspace, DocuShare provides templates and a
wizard.

When adding a workspace, a membership group is created automatically and initially
includes you as its member. You can add members to the group after the workspace is
added. The members are listed in the membership portlet on the workspace home page.

Note: If you are a Site Administrator or a Content Administrator, an [add] link appears on
the home page. This allows you to add a workspace to your site home page.

To add a workspace:

1. To add a workspace to another workspace, do one of the following and then go to
step 3:

*  Onthe DocuShare home page, click more under Workspaces. Search for the
workspace to which you want to add a workspace. Open the workspace and
select Workspace from the Add menu.

* Go to My DocuShare. In the workspaces portlet, search for the workspace to
which you want to add a workspace. Open the workspace and select
Workspace from the Add menu.

* Navigate to and open the workspace to which you want to add a workspace.
In the content portlet, select Workspace from the Add menu.

2. To add a workspace to My DocuShare, do one of the following:

*  On the DocuShare home page, click more under Workspaces. Then click
Add a Workspace.

* Go to My DocuShare. In the workspaces portlet, click Add a Workspace.
3. On the Add a New Workspace page, select one of the following templates:

+ Document Storage—includes four workspace collections in the content
portlet.

* Team Project—includes one workspace collection, a calendar, and a
collection for online meeting URLSs in the content portlet.

4. Click Next.
In the Title field, enter a name for the workspace.

6. Enter any optional information. Click a field name for a description of each
property.

7. Click Done.

The workspace home page appears.
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Controlling access to the workspace

To change the users and groups that have access to the workspace, you simply change
the members of the workspace membership group. Any user or group that you add to the
group is assigned full read and write permissions to the workspace. You can choose to
give the group manage permission to the workspace.

In addition to listing the group members, the membership portlet enables you to see which
users are logged into DocuShare. The user icon next to the user’s name in the portlet
indicates whether or not the user is logged in; the icon is grayed when the user is not
logged in.

Like other DocuShare objects, a workspace has an access list, which you can use to give
users and groups access to the workspace. However, any users and groups that you add
to the access list are not listed in the membership portlet.

Changing the users and groups in the membership
group

If you are the workspace owner or a member of the membership group (and the group is
assigned manage permission to the workspace), you change the users and groups in the

group.

Note: The membership portlet lists users only. Therefore, individual group members are
listed and not the group titles.

To change the members of the membership group:

1. On the workspace home page, do one of the following:
* Click the Membership heading.
« Click the Properties icon. On the Properties page, click the Membership link.
The Membership page appears showing the current members.

2. Click the Change Membership link.

In the Show field, select the type of account you want to display in the Possible
Users/Groups field.

4. Do one of the following:

» To find a specific account, enter part of the user’s first name, last name, or
username or the group’s title in the Search field. Click the Go button.

« To list all accounts, click Show All (if displayed).
« To display your favorite accounts, click Show Favorites.

5. Inthe Possible Users/Groups field, select the accounts to add to the group and
click the Add button. To select multiple accounts, use the CTRL key (Windows) or
the Command key (Macintosh).

6. Inthe Selected Users/Groups field, select any accounts that you want to remove
from the group and click the Remove button. To select multiple accounts, use the
CTRL key (Windows) or the Command key (Macintosh).

7. Click Update.
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The Members page appears.

To give one or more members manage permission to the group, click the
checkbox next to each member’s name and then click Apply. Manage permission
allows the member to change the group’s properties and membership.

To assign manage permission to the membership group, display the Permissions
page for the workspace. Click the Manage or Manager box for the group and click

Apply.

Re-assigning the membership group

As needed, you can change the membership group that is associated with the workspace
by assigning a different group to the workspace.

To re-assign the membership group:

1.
2.

On the workspace home page, click the Properties icon.
On the Properties page, click the Permissions link.
Click the Re-assign Membership Group button.

The Re-assign Membership Group page appears.

Do one of the following:

» Tofind a specific group, enter part of the group’s title in the Search field. Click
the Go button.

« To list all groups, click Show All (if displayed).
» To display your favorite groups, click Show Favorites.

In the New Membership Group field, select the group you want to associate with
the workspace.

Click Save.

The previous membership group remains in the workspace’s access list.
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Adding content to the workspace
You can add any type of object, including another workspace, to a workspace.
To add content to the workspace:

1. In the content portlet, select the type of object that you want to add from the Add
menu.

2. On the Add page, enter the required information and click Apply.

The object appears in the content portlet.

To use workspace view features:

1. From the Show menu, select the type of object you want to display.

2. Click a View icon to switch between the icon and list views.
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Managing shortcuts

To conveniently access frequently used objects from a workspace, you can add shortcuts
to them. Any object you add as a shortcut is a link to the original object, not a copy. If the
original object is deleted, it will no longer appear as a shortcut.

To add a shortcut to a workspace:
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Locate the object that you want to add as a shortcut.

Click the checkbox that appears next to the object’s title.

From the Edit Selected menu, select Copy Shortcuts.

On the Confirm Copy Shortcuts page, click Confirm.

Navigate to and open the workspace to which you want to add the shortcut.
In the shortcuts portlet, click the Paste Shortcuts icon.

On the Confirm Paste Shortcut page, click Confirm.

The object you added appears in the shortcuts portlets. You can use the Show
menu to display one type of object, such as documents. The View icons let you
switch between the icon and list views.

To remove a shortcut from a workspace:

1.

7-6

Navigate to and open the workspace that contains the shortcut that you want to
remove.

In the shortcuts portlet, click the List View icon to display the shortcuts in a list.

Click the Remove Shortcut icon that appears next to the object you want to
remove.

On the Confirm Remove Shortcut page, click Confirm.

The object no longer appears in shortcuts. However, the object still appears in its
original location(s).
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Using calendars

The calendars portlet shows all of the calendars from the content portlet. This allows you
and other workspace members to quickly access individual calendars as well as to view
the events from all calendars.

To use the calendars portlet:

1. From the Show menu, select the calendar that you want to view or select All
Calendars to view all calendars.

2. Using the View icons, you can switch between daily and weekly calendar views.
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Changing portlet properties
Each portlet has default display properties that you can change. For example, you can set
the default view to list view to display objects in a collection-style listing.

To change the properties of a portlet:

1. Click the portlet’s Edit button.

2. Depending on which portlet properties you are changing, do one or all of the
following:

a. Inthe Page Size field, enter the number of objects to show on each page.
b. In the Sort Order field, enter the order in which to display objects.

c. Inthe View Type field, enter the type of view used to display objects.
Click a field name for a description of each property.

3. Click Apply.
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About social computing features

DocuShare enables you and other users to discuss, share, and collaborate regardless of
location using its social computing features:

» Discussions—A discussion is an online forum that allows users to interact by
posting topics and replies to topics.

*+  Weblogs—A weblog allows a user to create and share a personal website on a
particular subject. The weblog includes postings in reverse chronological order
and allows others to comment on the postings.

»  Wikis—A wiki enables a group of users to collaborate on a website by creating,
editing, and linking web pages.
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Adding a discussion

To facilitate an online exchange of ideas, DocuShare supports threaded discussions. You
can add a container, called a discussion, in which users add topics for other users to read
and reply to. As users reply to a topic, their responses are sequentially linked, or threaded,
to the original topic. Users can read or reply to any of the topics or replies in a thread as
well as attach a document to a topic or reply.

You can add a discussion to a collection or workspace.
To add a discussion:

1. Navigate to and open the container to which you want to add a discussion.
2. From the Add menu, select Discussion.
The Add Discussion page appears.

3. In the Title field, enter a name for the discussion. The name should be short, but
descriptive, and can contain spaces and punctuation marks.

4. In the Topics Expire In field, select the length of time to retain topics and their
message threads in the discussion after they are added.

When a topic becomes older than the duration you select, it no longer appears in
the discussion. You can view and delete expired topics on the discussion’s View
Expired page.

5. Enter any optional information. Click a field name for a description of each
property.

Note: If your administrator created custom properties, they also display on the
page. See your administrator for information about custom properties.

6. Click Apply.

The discussion is added to the container.

Adding topics and replies to a discussion

A topic is the first message added to a discussion and initiates the online conversation.
Users can reply to the topic as well as to individual replies. By default, replies are
indented, which provides a hierarchical display of the discussion.

To add a topic:

1. Open the discussion to which you want to add a topic.

2. Click the Add Topic button.
Note: If your administrator created a custom topic, it appears in the Add menu.
In the Title field, enter a name for the topic.

4. In the Description field, enter the body of the topic.
Click Submit.

The topic is added to the discussion.
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6.

If you want to attach a document to the topic, do the following:
a. Click the Attach button.
The Add Document page appears.

b. Enter the complete path and filename of the document in the Filename field
or click the Browse button to navigate to and select the document.

c. Inthe Title field, enter a document name.

d. Click Apply.

The document appears on the topic.

To add a reply:
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Navigate to and open the discussion.

Locate the topic or reply to which you want to reply.
Click the Reply button.

Enter a title and description.

If you want to include the previous message and the name of the user who added
it, click Quote Post.

Click Submit.
If you want to attach a document to the reply, do the following:
a. Click the Attach button.

The Add Document page appears.

b. Enter the complete path and filename of the document in the Filename field
or click the Browse button to navigate to and select the document.

c. Inthe Title field, enter a document name.

d. Click Apply.

The document appears on the reply.

Viewing and deleting expired topics

If you set an expiration for the topics added to a discussion, you can view and delete the
expired topics.

To view and delete expired topics:

1.
2.

Locate the discussion whose expired topics you want to view.

Click the Properties icon that appears to the right of the discussion’s title.
The View Properties page appears.

Click the View Expired link.

The page displays all of the expired topics that no longer appear on the
discussion.

Do one of the following:

»  Select the individual topics that you want to delete.
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* Click Select All to select all of the topics.
5. Click Delete Selected.
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Adding a weblog

A weblog is a simple web site on which you post entries about a specific topic on a regular
basis. Entries are displayed in reverse chronological order and include the name of the
user who posted the entry.

When adding a weblog, you can choose to have it moderated. A moderated weblog
requires a user with manage permission to the weblog to approve its entries before they
are posted for all users to read.

You can add a weblog to a collection or workspace. By default, when you add a weblog,
you are the only user who can post entries to it (Initial Permissions is set to Same as
container except write restricted to owner). If you want other users and groups to add
entries to the weblog, either change the Initial Permissions setting when adding the
object or change the object’'s permissions after adding it.

To add a weblog:

1. Navigate to and open the container to which you want to add a weblog.
2. From the Add menu, select Weblog.
The Add Weblog page appears.

3. In the Title field, enter a name for the weblog. The name should be short, but
descriptive, and can contain spaces and punctuation marks.

4. Change any of the default property values and enter any optional information.
Click a field name for a description of each property.

Note: If your administrator created custom properties, they also display on the
page. See your administrator for information about custom properties.

5. Click Apply.
The weblog is added to the container.

Note: When you create a weblog using a custom theme, that theme is used to display
weblog pages. Any theme you select on your User Properties page has no affect on the
weblog pages. When you create a weblog using a default or clean theme, the theme you
select on your User Properties page is used to display weblog pages.

Posting weblog entries

To add content to a weblog, you post entries to it. By default, entries appear in reverse-
chronological order.

To post an entry:

1. Locate and open the weblog to which you want to post an entry.
2. Click the Add Entry link.
The Add Weblog Entry page appears.

3. In the Title field, enter a name for the entry. The name should be short, but
descriptive, and can contain spaces and punctuation marks.

4. In the Description field, enter the body of the entry.
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5. Enter any optional information. Click a field name for a description of each
property.

Note: If your administrator created custom properties, they also display on the
page. See your administrator for information about custom properties.

6. Click Apply.

The entry appears in the weblog and includes the date the entry was posted and
your username. If the weblog is moderated, Approval Pending precedes your
username. Users cannot read the entry until a user with manage permission to the
weblog approves it.

Editing weblog entries
To edit an entry:

1. Locate and open the weblog that contains the entry you want to edit.
2. Click the Edit icon next to the entry.

3. Make the changes you want.

4. Click Apply.

Deleting weblog entries

To delete a weblog entry:

1. Locate and open the weblog that contains the entry you want to delete.
2. Click the weblog entry title.
3. From the weblog entry’s More actions menu, select Delete.

The Confirm Delete page appears.

4. Click Delete to remove the object from your site.

Approving weblog entries

If you are a user with manage permission to a weblog that is moderated, you must
approve an entry before it is posted for all users to read.

To approve an entry:

1. Do one of the following:

* Locate and open the weblog that contains the entry you need to approve.
Click the checkmark next to the entry.

*  On the navigation bar, click My Tasks. From the Show menu, select Tasks
Assigned to Me. Click the weblog entry title.

*  On the navigation bar, click My DocuShare. The tasks assigned to you
display under Tasks. Click the weblog entry title.

A For Your Approval window appears.
2. Click the title of the entry to review the text.
3. Click the Approved button.
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Adding comments to entries

To provide feedback or commentary on a weblog entry, you can add a comment to it.

To add a comment:
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Locate and open the weblog entry to which you want to add a comment.
Click the Add a Comment link.

In the Title field, enter a comment title.

In the Description field, enter the comment text.

Click Apply.

Viewing comments

To view comments:

1.

Locate and open the weblog.

The weblog entries display. A Comments link appears for an entry that includes
comments.

Click a Comments link.

The comments display in reverse chronological order and include the name of the
user who posted the comment.

Deleting comments

If you are the user who added the comment or the user who added the entry, you can
delete the comment.

To delete a comment:

1.
2.

Locate and open the weblog entry that includes the comment you want to delete.
Click the comment title.

From the More Actions menu, select Delete.

The Confirm Delete page appears.

Click Delete to remove the comment.
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Adding a wiki

A wiki allows you and other users to quickly and easily publish content on the web. Using
a web browser and either the built-in WYSIWYG (What You See Is What You Get) editor
or simple wiki syntax, you can add and link web pages and edit content instantly. Wikis are
well-suited for any type of project that requires collaborative writing.

By default, you use the WYSIWYG editor to create wiki content. Your user account
property Text Composition Format specifies whether or not to use the WYSIWYG editor
(Rich Text) or wiki syntax (Plain Text). Should you want to use wiki syntax, change the
Text Composition Format property or, after adding the wiki, deselect the wysiwyg
checkbox on the Add WikiPage. Once you have selected the editing method, you should
continue to use it after adding the page.

To get started, you first add a wiki to a collection or workspace and then add content to it.
To add a wiki:

1. Navigate to and open the container to which you want to add a wiki.
2. From the Add menu, select Wiki.
The Add Wiki page appears.

3. In the Title field, enter a name for the wiki. The name can contain spaces and
punctuation marks.

4. Enter any optional information. Click a field name for a description of each
property. To add interwiki links, see Using interwiki links on page 8—11.

Note: If your administrator created custom properties, they also display on the
page. See your administrator for information about custom properties.

5. Click Apply.
The wiki is added to the container.

Note: When you create a wiki using a custom theme, that theme is used to display wiki
pages. Any theme you select on your User Properties page has no affect on the wiki
pages. When you create a wiki using a default or clean theme, the theme you select on
your User Properties page is used to display wiki pages.

Adding content to a wiki

You add content to the wiki by editing the wiki home page, creating and linking additional
wiki pages, inserting images, and attaching documents.

By default, each wiki page includes a WYSIWYG editor for easy formatting of content.
Alternatively, you can use the wiki syntax provided in a sidebar on a wiki page. However,
when editing a wiki page, you should use the same method you used to create the page.
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Adding content to the wiki home page

After adding the wiki, your first step is to add content to the home page.

To add content to the home page:

1.

Locate and open the wiki to which you want to add content.
The Add WikiPage appears and the page is titled HomePage.

In the Description field, enter the page content using one of the following
methods:

* Use the WYSIWYG editor. The editor appears when your user account
property Text Composition Format is set to Rich Text and the wysiwyg
checkbox is selected on the Add WikiPage.

+ Deselect the wysiwyg checkbox. Use the wiki syntax displayed in the
sidebar.

Note: When using wiki syntax, HTML tags are used on the page. When you want
to include angle brackets on the page, either use the WYSIWYG editor or type
&lt;text> to have the angle brackets and text appear. Similarly, to have the
ampersand character (&) appear, type &amp;.

Click Apply.

The wiki home page appears with your content.

Linking pages to a wiki

You can add any number of web pages to the wiki. You first add the link to the page and
then enter content on the page.

To link a page to the wiki:

1.
2.

Open a wiki page and click Edit This Page.

On the Edit Wiki page, enter the new page name between double square
brackets.

Example: [[New Wiki Page]]
Click Apply.

The page appears showing the page name you entered followed by a question
mark.

Click the page name.
The Add WikiPage appears.

In the Description field, enter the page content using either the WYSIWYG editor
or wiki syntax.

Click Apply.

The pages are linked.

Note: To list the pages linked to a wiki page, view the wiki page and click Backlinks. The
linked pages are listed on the Search Results page.
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Inserting images

On a wiki page you can insert an image that is located on an external URL or on the same
DocuShare server.

To insert an image on a wiki page using the WYSIWYG editor:

1. Do one of the following:

+ Toinsert an image located on an external URL, select the text to link to the
image and click the Insert/Edit Link button on the WYSIWYG bar. Enter the
complete URL to the image and click Insert.

« Toinsert an image located on the same DocuShare server, enter
{image:Document-#}. The pound symbol (#) represents a number.

2. Click Apply.

To insert an image on a wiki page using wiki syntax:

1. Do one of the following:
+ Toinsert an image located on an external URL, enter {image:url}.

+ Toinsert an image located on the same DocuShare server, enter
{image:Document-#}. The pound symbol (#) represents a number.

2. Click Apply.

Attaching documents

On a wiki page you can add a link to a document that you upload to DocuShare.
To attach a document to a wiki page:

1. Open a wiki page and click Attach.
The Add Document page appears.

2. Enter the complete path and filename of the document in the Filename field or
click the Browse button to navigate to and select the document.

3. In the Title field, enter a document name.

4. Click Apply.

5. On the wiki page, click Edit This Page.

6. On the Edit Wiki page, enter the document name that you used in step 3 between
double square brackets.
Example: For more information, see our [[brochure]].

7. Click Apply.
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Using interwiki links

The use of interwiki links allows you to create links to external wiki sites on your wiki pages
without typing or pasting URLs. Before adding the links to your wiki pages, you must map
each wiki name to its URL.

To use interwiki links:

1. Locate the wiki and click its Properties icon.
2. Click the Edit link.
Under Inter Wiki Links, enter the following:

+ Name—The name to enter when creating the link on the wiki page. Example:
wikipedia.

+ Prefix—The URL of the wiki. Example: http://en.wikipedia.org/wiki/.
4. To add another interwiki link, click the plus sign (+).

If you need to remove an interwiki link, click the trashcan located to the right of
the link.

6. To create a link on a wiki page, edit the page by entering [[page title@wiki namel]].
Example: [[ltaly@wikipedia]].

Renaming wiki pages
To rename a wiki page:

1. Locate and open the wiki page that you want to rename.
2. Click Rename This Page.

3. In the Title field, enter a new name; then click Rename.
4. On the confirmation page, click OK.

Note: You cannot rename the wiki home page.

Printing wiki pages

You can print some or all of your wiki pages to review the content on the pages or to have
a printed copy of the wiki.

To print wiki pages:

1. Locate and open the homepage of the wiki that you want to print.
2. Click Printable View.

The view shows the top two levels of the wiki, with the homepage as the top level,
or level one.

3. To view other wiki pages, do any of the following:
+ Toremove one level of pages from the view, click Subtract One Level.

+ To add one level of pages to the view, click Add One Level.
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+ Todisplay all levels of pages, click Show All Levels. When viewing all levels,
you can click Show Two Levels to view the top two levels of the wiki.

4. Use the Print command from the File menu to print the wiki view.
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Routing documents

During a document’s development cycle, you often need to solicit feedback from others,
receive approval of the document’s content, or simply share the information in the
document. DocuShare enables you to automate the routing of documents to users and
request a specific action after the users receive the documents.

On a form called a Routing Slip, you indicate the users to whom the document should be
sent, the type of action you want the users to take, and a message describing the
document task. You then submit the Routing Slip; DocuShare notifies the specified users
of the document task. While a task is in progress, you can monitor its status.

Note: To use document routing, your administrator must configure the server to allow
Javascript. Your user account properties must have Enable Javascript set to Yes.

Creating a routing task

You can route an existing document on your site or you can choose to route a document
when adding it to DocuShare. In addition, you can route an individual document version.
On the Routing Slip that accompanies the document, you can request users to approve
the document, review the document and provide changes, or acknowledge receipt of the
document, or you can provide the document for information only.

When creating a routing task, you can define a single routing step or several sequential
steps. A single routing step consists of one type of action, such as sending a document to
users for approval. A multi-step routing task enables you to automate a document
process. For example, you can create a routing task to send a document to a group of
users for their review and comment before sending the revised document for approval.

To route a document:

1. Do one of the following:

+ To route a single document, locate the document or document version that
you want to route and click its Route icon. A Route icon does not appear if
the document is locked.

Note:Document versions are located on a document’s Version History page.

« To route several documents, locate the documents and click the checkbox
next to each document. From the Edit Selected menu, select Route. On the
Confirmation page, click Confirm.
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* To route a document after adding it to DocuShare, select Document from
the Add menu. Enter the required information and click Publish and then
route the document before clicking Apply.

* To route a document before it appears in DocuShare, select Document
from the Add menu. Enter the required information and click Route the
document and publish it later before clicking Apply.

A Routing Slip appears.

If you want to include another document, click the Add button. Locate the
document and click its Route command; then confirm adding the document to the
Routing Slip.

If you want to use a saved Routing Slip, do one of the following and then go to
step 19:

»  Select one of your saved Routing Slips and click Load.

» Click View all Saved Routing Slips to display your saved Routing Slips and
the public Routing Slips saved by all site users. Select a Routing Slip.

Under Routing Action, choose one of the following:

* Approve or Disapprove—Requires users to approve or not approve the
document.

* Review and Make Changes—Allows users to provide comments and a
revised version of the document. Click Share Changes with Recipients if
you want each recipient to see the previous recipient’s changes.

* Acknowledge Receipt—Provides the document to users for information and
requires the users to confirm receiving the document.

* Information—Provides the document to users for information only.

Depending on the routing action you selected, choose one of the following
Routing Orders:

* In Order—Routes the document to users in the order in which they are listed
in the Selected Users/Groups field. If a user does not approve the
document, it is not routed to subsequent users.

+ At the Same Time-Single Reply—Routes the document to all users
simultaneously and only one user’s reply is needed to complete the routing
task.

+ At the Same Time-All Reply—Routes the document to all users
simultaneously and all users must reply to complete the routing task.
However, if one user does not approve the document, it is not routed to other
users.

+ At the Same Time-Majority Reply—Routes the document to all users
simultaneously and more than half of the users must reply to complete the
routing task.

Under Routing Message, do the following:

* Inthe Subject field, enter a brief topic that appears in the notification or email
that the user receives.

* Inthe Comments field, enter a message.

Click Next to go to the Add Recipients page.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

In the Show field, select the type of account you want to display in the Possible
Users/Groups field.

Do one of the following:

» To find a specific account, enter part of the user’s first name, last name, or
username or the group’s title in the Search field. Click the Go button.

» Tolist all accounts, click Show All (if displayed).
» To display your favorite accounts, click Show Favorites.

In the Possible Users/Groups field, select the accounts to add to the list of
recipients and click the Add button. To select multiple accounts, use the CTRL
key (Windows) or the Command key (Macintosh).

In the Selected Users/Groups field, select any accounts that you want to remove
from the list of recipients and click the Remove button.

To show the members in a group, select the group in the Selected Users/Groups
field and click Show Group Members. The group members replace the group title
and the routing task is sent to each user and not to the group.

To reorder the recipients in the Selected Users/Groups field, select an account
and do one of the following:

» To move the recipient before another recipient, click Move Up.
» To move the recipient after another recipient, click Move Down.

Click Next to go to the Choose Escalation and Notification page (the page does
not appear if you are routing the document for information).

Select If Not Complete and do the following:

+ To specify a completion date, select By and enter a date or select Within and
specify a time period.

» To specify an escalation action if the routing task is not complete by the
specified date, choose an action from the Then Escalate menu.

Under Notify Me, choose any of the following:

»  Of Escalation—Notifies you of the escalation action.

+ Of Task Progress—Notifies you of the routing status after each user action.
*  When Task Is Complete—Notifies you when each routing step is complete.

To check for notifications, click the My Tasks link on the navigation bar and select
Tasks Assigned to Me.

Click Done and review the routing information for the task on the Routing Step
Review page.

To save the Routing Slip, click Save Routing Slip. Enter a name for the Routing
Slip and keep Save as private selected if you do not want to share the Routing
Slip with other users. Then click OK.

Do one of the following:
*  Click Submit to start the routing task.
» Click Back to change any of the routing information.

» Click Add Step to add another step to the routing task.
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Note: If you chose Route the document and publish it later in step 1, you must publish
the document for it appear in DocuShare. For information on how to publish the document,
see Routing documents on page 9—4.

Setting up a collection for routing documents

You can have any document added to a collection automatically routed by associating one
of your saved, private Routing Slips with the collection.

To use a Routing Slip with a collection:

1. Locate the collection you want to use for routing documents.

2. Click the Properties icon that appears to the right of the collection’s title.
3. Click the Edit link.
4

In the Route Before Publishing field, select Yes to route the document before it
is added to the collection.

In the Use Routing Slip field, select the Routing Slip that you want to use.
Click Apply.

Checking the status of routing tasks you assigned

You can check the status of completed and pending routing tasks that you assigned to
other users. Once a task is complete, you can choose to delete it, keep a record of it, or
publish the document to add it to DocuShare.

To check the status of a routing task:

1. Do one of the following:
«  On the navigation bar, click My Tasks.
* On the navigation bar, click My DocuShare. Then click Tasks.
The My Tasks window appears.

2. From the Show menu, select Tasks Assigned by Me.

The page lists the routing tasks, under Description, the date the task began, and
the status. Table 9—1 describes the status information.

Table 9-1: Task status

Status Description

Approved The single-step task or one step of a multi-step task is
complete and the recipient(s) approved the document(s).

Disapproved The single-step task or one step of a multi-step task is
complete and the recipient(s) did not approve the
document(s).

Reviewed The single-step task or one step of a multi-step task is

complete and the recipient(s) reviewed the document(s).
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Table 9-1: Task status

Status Description

Acknowledged The single-step task or one step of a multi-step task is
complete and the recipient(s) acknowledged receiving the
document(s).

Delivered The single-step task or one step of a multi-step task is

complete and the recipient(s) received the document(s) for
their information.

All Steps Completed

The multi-step task is complete.

Started

The task is pending. It is currently being routed to all
recipients at the same time for approval, review, or
acknowledgement.

Username

The task is pending. It is currently being routed to all
recipients in order; the user whose name is displayed has
received the document, but has not taken any action.

Step #

The task is pending and is on a specific step of a multi-
step task.

Step #: Username

The task is pending and is on a specific step of a multi-
step task. It is currently being routed to all recipients in
order; the user whose name is displayed has received the
document, but has not taken any action.

Overdue For a single-step task or one step of a multi-step task that
is overdue, the word Overdue appears after the task’s
description.

Terminated The task is stopped because it cannot continue. This can

occur when Cancel Task is set for Then Escalate or when
a document or user is deleted from your site.

3. To view more information about the task, click the task’s description.

A Report on Routing window appears, which shows the status of each user

assigned the task.

4. Do one of the following:

+ To view an individual recipient’'s comments, click the user’s name.

» To view all recipient comments, click Show all User Comments. If you want,
you can save the comments to a text file.

Close the window after viewing the comments.

5. To view the user’s changes to the document, click the document’s title.

6. Close the document after viewing the changes.

If the task is complete, do one of the following:

+ To move a task from the Tasks Assigned by Me list to your Deleted Tasks,
click Delete This Job.
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* To complete the task later, click Keep for Later. The task remains in the
Tasks Assigned by Me list.

»  To publish a document that has not been added to DocuShare (the word
Unpublished appears after the document’s title), click the Properties icon that
appears to the right of the document’s title. At the bottom of the View
Properties page, click the Publish This Version button.

If the document was routed for approval and it was not approved, you can
reroute the unpublished document by clicking the Route icon that appears to
the right of the document’s title.

Viewing progress reports

If you chose to be notified of a task’s progress, completion, or overdue status on the
Routing Slip, you can view the notifications in the Routing Tasks window.

To view a task’s progress report:

1.

Do one of the following:

*  On the navigation bar, click My Tasks.

»  On the navigation bar, click My DocuShare. Then click Tasks.
The My Tasks window appears.

From the Show menu, select Tasks Assigned to Me.

The page lists the routing tasks, under Description, the date the task was
assigned, and the type of report. Table 9-2 describes the report types.

Table 9-2: Report type

Type Description

Response The recipient responded to the task.

Completion The task is complete.

Overdue The task is in progress past the completion date.

Termination The task is stopped because it cannot continue. This can
occur when a document or user is deleted from your site.

9-6

To view a task’s progress report, click its Description.

A window appears, which includes the routed document and shows the user’s
comments.

To view the user’s changes to the document, click the document’s title.

You can save the user’s revised document as a new version of your routed
document. See the next section, Checking the status of routing tasks you
assigned on page 9-7.

Close the document after viewing the changes.

In the Response to Routing window, do one of the following:
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« To schedule a new due date for an overdue task, enter a new date in the Due
Date field and click the Acknowledged button.

« To confirm reviewing the report, click the Acknowledged button.

« To review the report at a later time, click the Acknowledge Later button.

Publishing a new version of your routed document

If you routed a document for review, you can save a document that a recipient changed as
a new version of your routed document. In the For Your Review window, the word New
appears after the title of a document that a recipient changed.

To publish a new version of your routed document:

1.
2.
3.

11.
12.
13.

14.
15.

© o ® N o

In the My Tasks window, select Tasks Assigned by Me.
Under Description, click the task that includes the changed document.

In the Report on Routing for Review window, click the name of the recipient who
provided the changed document.

Click the document title to open it.

Save the document to a location on your computer, and then close the document
window.

In the Report on Routing for Review window, click the Close button.

Click the Properties icon that appears to the right of the document’s title.

At the bottom of the View Properties page, click the Publish New Version button.
On the Add Version page, click the Browse button.

Navigate to the location on your local drive in which you saved the document in
step 5, select it, and click Open.

The path to the document appears in the Filename field.
Optionally, change the document title and add a version comment.
Click Apply.

If a document version other than the latest is the preferred version, you are asked
if you would like to set this version as the preferred version. Click Yes to change
the preferred version; otherwise, click No.

For more information on document versions and the preferred version, see
Managing document versions on page 5-7.

Click the Report on Routing for Review link in the Location path.
In the Report on Routing for Review window, do one of the following:

*  To move the task from the Tasks Assigned by Me list to your Deleted Tasks,
click Delete This Job

* To remove the task later, click Keep for Later. The task remains in the Tasks
Assigned by Me list.
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Viewing the tasks assigned to you

The tasks assigned to you display in the My Tasks window or on My DocuShare. If you
chose to receive an email message when a new task is assigned to you, the message
includes a URL to the task.

Note: To receive an email message when a new task is assigned to you, your user
account property Routing Task Notification must be set to Email and your email address
must appear in the Email Address field.

To view the tasks assigned to you:

1.

2.

Do one of the following:

*  On the navigation bar, click My Tasks. From the Show menu, select Tasks
Assigned to Me. Any task marked Request is a task assigned to you.

» On the navigation bar, click My DocuShare. The tasks assigned to you
display under Tasks.

Click a task to view it.

A window appears displaying your task. The following sections describe how to
respond to routing tasks.

Approving or disapproving a document

1.

N o o s~ oD
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In the For Your Approval window, click the document’s title.

The document opens in its native editor or a window appears allowing you to
download the document.

Note: If the document version sent to you is not the latest version, a Latest
published version link is included. You can click the link to view the latest version
of the document.

Review the document.

When your review is complete, close the document.

You can repeat steps 1 through 3 for each routed document.

In the Comments field, enter an optional message.

Click Save as private if you do not want other recipients to view your comments.
Do one of the following:

» To complete the task and approve the document, click the Approved button.
The task is removed from the Tasks Assigned to Me list.

+ To complete the task but not approve the document, click the Disapproved
button. The task is removed from the Tasks Assigned to Me list.

« To not complete the task at this time, click the Respond Later button. The
task remains in the Tasks Assigned to Me list.
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Reviewing a document

1.

© N o o

In the For Your Review window, click the document’s title.

The document opens in its native editor or a window appears allowing you to
download the document.

Note: If the document version sent to you is not the latest version, a Latest
published version link is included. You can click the link to view the latest version
of the document.

Review the document and make any changes you want.

Close the document and, if you made changes, save it to a location on your
computer.

If you changed the document, do the following:

a. Click the Properties icon that appears to the right of the document’s title.

b. At the bottom of the View Properties page, click the Add Draft Version
button.

On the Add Version page, click the Browse button.

Navigate to and select the document you changed, and then click Open.
Optionally, change the document title and add a version comment.

On the Add Version page, click Apply.

On the View Properties page, click the For Your Review link in the Location
path.

@ m o oo

You can repeat steps 1 through 4 for each routed document.

In the Comments field, enter an optional message.

Click Save as private if you do not want other recipients to view your comments.
Do one of the following:

+ To complete the task and remove it from the Tasks Assigned to Me list, click
the Reviewed button.

* To not complete the task at this time, click the Review Later button. The task
remains in the Tasks Assigned to Me list.

Acknowledging receipt of a document

1.

2.
3.

In the For Your Acknowledgement window, click the document’s title.

The document opens in its native editor or a window appears allowing you to
download the document.

Note: If the document version sent to you is not the latest version, a Latest
published version link is included. You can click the link to view the latest version
of the document.

When you are finished viewing the document, close it.

You can repeat steps 1 and 2 for each routed document.
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Do one of the following:

+ To complete the task and remove it from the Tasks Assigned to Me list, click
the Acknowledged button.

+ To not complete the task at this time, click the Acknowledge Later button.
The task remains in the Tasks Assigned to Me list.

Removing a document sent for information

1.

In the For Your Information window, click the document’s title.

The document opens in its native editor or a window appears allowing you to
download the document.

Note: If the document version sent to you is not the latest version, a Latest
published version link is included. You can click the link to view the latest version
of the document.

2. When you are finished viewing the document, close it.

3. You can repeat steps 1 and 2 for each routed document.

4. Do one of the following:

« To complete the task and remove it from the Tasks Assigned to Me list, click
the Remove button.

» To not complete the task at this time, click the Remove Later button. The task
remains in the Tasks Assigned to Me list.

Viewing your deleted tasks

After you delete a completed task that you assigned by clicking the Delete This Job
button, DocuShare saves the task. This provides you with a record of the completed
routing tasks you assigned.

In addition, you can view the deleted routing tasks of a specific document. See Routing
documents on page 9-11.

To view all of your deleted tasks:

1.

Do one of the following:

«  On the navigation bar, click My Tasks.

* On the navigation bar, click My DocuShare. Then click Tasks.
The My Tasks window appears.

From the Show menu, select Deleted Tasks.

Your deleted routing tasks display.
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Viewing the routing tasks of a document

The routing task owner and each recipient can view the routing status of a document or
any of its versions on the Routing page for the document. The page displays both tasks in
progress and deleted tasks.

To view a document’s routing tasks:

1. Do one of the following:
* Locate the document whose tasks you want to view.

* Open a routing report or request window that contains the document whose
tasks you want to view.

2. Click the Properties icon that appears to the right of the document’s title.
The View Properties page appears.
3. Click the Routing link.

The tasks and their status display.
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Using content rules

A content rule allows you to have an action run automatically when a specific event
occurs. For example, you can create a content rule for a collection to route any document
added to the collection. Or, you can create a content rule for a document to have an email
message sent when a new version of the document authored by a specific user is added.
You can add a content rule for any object on your site.

You can have an action run when any of the events described in Table 9-3 occur.

Table 9-3: Events

Event Name When Event Occurs

Any change

Any one of the changes listed in this table.

Document locked or
checked out

The document is locked or checked out for editing.

Document unlocked

The document is unlocked.

Location edited

The location of an object is changed, using either the
Locations page or copy/cut and paste.

New document version
added

A document is updated with a newer version.

Owner changed

The owner of an object is changed.

Note: When changing the owner of a document, you
can optionally change the owner of the document
versions; when changing the owner of a container, you
can choose how to change the owner of the container
and its contents. Therefore, the owner change can be
the result of how the change is applied.

Permissions changed

The permissions of an object are changed.

Note: When changing the permissions of a document,
you can optionally change the permissions of the
document versions; when changing the permissions of
a container, you can choose how to change the
permissions of the container and its contents.
Therefore, the permissions change can be the result of
how the change is applied.

Properties edited

The properties of an object are changed.

Routing

A change occurred to the status of a routing task.

Something added

A new object is added to a container, using either the
Add menu or copy/cut and paste.
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Creating a content rule

DocuShare provides a wizard to guide you in creating a content rule. Using the wizard,
you provide a brief description of the content rule, select the event that triggers the action,
select the action to run, and enter settings specific to the selected action.

To create a content rule:

1.
2.

Locate the object for which you want to create a content rule.

Do one of the following:

+  Click the object’'s Content Rules icon.

« Click the object’s Properties icon. Then click the Content Rules link.
On the Content Rules page, click Create a New Content Rule.

The Create a New Content Rule wizard appears. The following steps describe the
required fields. For information about any of the optional fields in the wizard, click
the appropriate field name.

On the Description page, enter a Title for the content rule and click Next.
On the Event Triggers page, select the event that will cause the action to run.

If the object is a container (collection, calendar, etc.), select one of the following
choices from the Event Applies To menu. The click Next.

« This container and immediate contents—Triggers the action when the
event occurs to the container and only its first nested level of objects.

For example, if a collection contains several objects and a subcollection, the
action is triggered when the event occurs to any of the objects and the
subcollection; the action is not triggered when the event occurs to an object in
the subcollection.

« This container and all levels of contents—Triggers the action when the
event occurs to the container and all of the objects under it.

For example, when the event occurs to any object in a collection regardless of
its nested level, the action is triggered.

Note:Your administrator sets the maximum number of objects DocuShare
examines to determine if the event occurred. The default is 30,000 objects.

On the Content Property Conditions page, refine the event trigger by specifying
property conditions. Then click Next.

On the Action Performed page, select the action to run when the event occurs and
click Next.

The Action Settings page appears. The options on the page vary depending on
the action you selected in the previous step.

Enter the appropriate information and click Next.

On the Completion Settings page, you can choose to set a property value on the
object when the content rule completes. In addition, you can append the property
value to any existing property values. Then click Done.

The View Properties page for the content rule appears and provides a summary of
the content rule.
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Changing content rules

At any time after creating a content rule, you can change its settings.
To change a content rule:

1. Locate the object whose content rule you want to change.
2. Do one of the following:
* From the object’'s More Actions menu, select Content Rules.
+  Click the object’s Content Rules icon.
The Content Rules page lists the object’s current content rules.
3. Do one of the following:
+ Click the Properties icon that appears to the right of the content rule.
*  Click the title of the content rule.
The View Properties page provides a summary of the content rule.
4. Click the Edit link.
On each Edit Content Rule page, make the changes you want and click Next.

6. On the last page, click Done.
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Deleting a content rule

Depending on how your site is set up, a deleted content rule can go to either your personal
trashcan on My DocuShare or the site-wide trashcan. Contact your administrator to find
out which trashcans are used on your site. If you have a personal trashcan, you can
restore an object from it as long as your administrator has not expunged the object from
the site-wide trashcan. See Using your personal home page for more information.

To delete a content rule:

1. Locate the object whose content rule you want to delete.

2. Do one of the following:
* From the object’'s More Actions menu, select Content Rules.
« Click the object’s Content Rules icon.
The Content Rules page lists the object’s current content rules.

3. Click the Delete icon for the content rule that you want to delete.
The Confirm Delete page appears.

4. Click Delete.
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About searches

DocuShare search features enable you to quickly find objects on your site. You can
perform simple word searches by having DocuShare find the objects that contain the text
you specify. You also can combine several search terms to find specific objects, such as
all documents authored by one user that contain the word DocuShare in their titles. When
searching for objects, you can choose the scope of a search.

When an object is added to a container, DocuShare indexes and stores in a database the
object’s properties (also called metadata) and, if the object is a document, its content. A
search checks the database to find the objects that match your search terms. In addition,
DocuShare uses a process called stemming to find objects that contain variations of the
word you specify. For example, a search for the word mouse will find the word mice.
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Viewing new content on your site

From any page, you can display a list of the content that has been added or changed on
your site. This lets you quickly find any new or recently changed object or content that
might be of interest to you.

To find out what’s new:

1. On the navigation bar, click What’s New.
DocuShare displays the list of content that has been added or changed.

2. To change the search query used to display the list of new or changed content,
click the Refine Search link.

The Refine Search page appears.

3. Change any of the search properties and click the Search button. Click a field
name for a description of the property, or see Running an advanced search on
page 10-5.

Note: If you are a guest and you click What’s New on the navigation bar, DocuShare lists
the content that has been added or changed during the past 24 hours. If you are a logged-
in user and you click What’s New on the navigation bar, DocuShare lists the content that

has been added or changed since you last clicked What’s New.

10-2 User Guide



Running searches Searching for objects

Searching for objects

The navigation bar provides a search area that lets you quickly search for objects and
content. You do not need to be logged into DocuShare to run a search.

To run a quick search:

1.

On the navigation bar, enter a word or phrase in the Search field. If you want to
find objects that include any one of several words, separate each word with a
comma. You can exclude common words such as from, it, and where.

DocuShare searches are not case-sensitive. If you want to search for a word with
exact capitalization, precede the word with a tilde character.

Note: You can combine search words using the logical operators AND, NOT, and
OR. Type the operator in uppercase letters and type a plus sign (+) before and
after the operator instead of a space (for example, fruits+AND+vegetables;
fruits+AND+vegetables+NOT+produce).

If you are running the search from a page other than the site home page, select a
search scope from the In menu.

Click Search.

DocuShare displays the search results. For documents, DocuShare either
provides a snippet of the document content with the search term highlighted or
displays the document’s abstract if the search term is not found in the content.
You can click the Show/Hide Details link to control this display.

If you searched all federated sites, DocuShare displays the search results from
the site on which you ran the search. To display the results from the other sites in
the federation, click each site name under Select a Federation Site.
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Search options

When running a quick search, you can specify several options to narrow the search and to
control how the search results are displayed.

To run a quick search using search options:

1.

104

Enter the search words in the Search field and, if the In field appears, select the
search scope.

Click the small triangle next to the Search field and specify any of the following
information:

Search Text Contained In—Specifies the location of the search words. Any Part
searches the object’s content and properties.

Last Modified—Limits the search to objects that were last changed within a
specific time period.

Object Types—Specifies the type of objects to search.

Document Types—Searches for all types of documents or a specific type. The
Object Types must be set to All Object Types or Documents Only.

Maximum Results—The maximum number of objects to display in the search
results list. DocuShare orders the results by displaying the most relevant objects
first.

Sort Results—The order in which to display the search results.
Click Search.

DocuShare displays the search results.
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Running an advanced search

Using the Advanced Search page, you can further narrow a search by combining search
terms, specifying ranges, and searching for specific objects and documents.

To run an advanced search:

1.
2.

On the navigation bar, click the Advanced link.

Under Search Text Contained In, enter the search term. Create a search term by
selecting an operator; entering the search word or words (separate each word
with a space) or the search character or characters; and then selecting where the
search words or characters should occur.

If you want DocuShare to search for an exact word, enclose the word in quotation
marks. If you want to search for a word with exact capitalization, precede the word
with a tilde character.

You can click + add search term to create another search term using a logical
operator. See Table 10—1 for a description of each logical operator.

Note: For information on how to use wildcard and non alphanumeric characters in
a search term, see Using reserved characters in a search on page 10-7.

If you are running the search from a page other than the site home page, select a
search scope from the Search Within menu.

In the Maximum Results field, select the maximum number of objects to display
in the search results list. DocuShare orders the results by displaying the most
relevant objects first.

In the Sort Results field, select the order in which to display the search results.

Under Limit Search to Date Range, enter the date range to use when searching
for objects. Create a date range by selecting options from the menus and entering
a date.

You can click + add date range to create a second date range.

Under Find Results Using Relative Date, create a search relative to today’s date
by doing one of the following:

+ To create a relative search without a start or end date, select a date property,
select an operator, enter the number of days, and then select Days Ago or
Days from Now. You can click + add range and create another search term.

+ To create a search with start and end dates, select a date property, select an
operator, enter the number of days, and then select Days Ago or Days from
Now. Then click + add range and create another search term and enter 0 in
the days field.

Note: When you save a search query that uses a relative date and then run the
search at a later time, the query uses the date on which the search is run.

Under Find Results with Numeric Range, enter the numeric range to use when
searching for objects whose properties have numeric values.

You can click + add numeric range to create a second numeric range.

Note: This field appears if an object has a numeric property that is searchable.
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9. Under Object Types to Search, do one of the following:
+ To search all of the objects on the site, click Search all object types.

» To search specific objects only, click Limit search to selected object types
and select the objects to search from the list.

10. If you are searching for documents, under Document Types to Search, do one of
the following:

» To search all types of documents, click Search all document types.

» To search specific types of documents, click Limit search to selected
document types and select the types of documents to search from the list.
Each document type is specified by its MIME type.

11. Click the Search button.

DocuShare displays the search results. For documents, DocuShare either
provides a snippet of the document content with the search term highlighted or
displays the document’s abstract if the search term is not found in the content.
You can click the Show/Hide Details link to control this display.

If you searched all federated sites, DocuShare displays the search results from
the site on which you ran the search. To display the results from the other sites in
the federation, click each site name under Select a Federation Site.

Table 10-1: Logical operators

Logical operator Meaning

And Searches for objects that contain all of the search
terms.

For example: Search for objects where “Title contains
Training And Summary contains Basic Product.”

The search would return only objects that have the word
“Training” in the Title, and the phrase “Basic Product” in
the Summary.

Or Searches for objects that contain one of the search
terms.

For example: Search for objects where “Title contains
Advanced Or Summary contains Administrator.”

The search would return objects that have either the word
“Advanced” in the Title or the word “Administrator” in the
Summary, or both the word “Advanced” in the Title and
“Administrator” in the Summary.

And Not Searches for objects that contain one search term and
not the other.

For example: Search objects where “Title contains
Technology And Not Title contains Marketing.”

The search would return only those objects where
Technology was in the Title, but not return objects if
Marketing was also in the Title.
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Using reserved characters in a search

You can use these wildcard characters when building a search:

Question mark (?)—Specifies any single alphanumeric character.
For example: ?an returns ban, can, dan, fan, etc.

Asterisk (*)}—Specifies any number of alphanumeric characters in one word.
For example: corp* returns corporal, corporate, corporation, corpulent, etc.

To find objects that include a wildcard character, tilde (~), or double quotation mark (*), use
the equals operator, precede the character with one backslash (\), and select the specific
property name.
Example: To search for a document named *ReadFirst enter:

equals \*ReadFirst In Title.
To find objects that include other non alphanumeric characters, such as a parenthesis or
an equal sign (=), use the equals operator and select the specific property name.
Example: To search for (650) 123-4567, enter:

equals (650) 123-4567 /n (User) Phone
Note: The ampersand (&), at sign (@), dash (-), and underscore (_) are considered

alphanumeric characters and do not require any special treatment. For example, to search
for my_document.doc, enter my_document.doc.
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Saving a search query

After running an advanced search, you can save the search query so you can run the
same search again at a later time or share it with other users. To save a search query, you
must be logged in.

To save the query used in a search:

1.

10-8

Define your search terms and run a search.

The search results display.

From the Add menu, select Saved Query.

The Add Saved Query page appears.

In the Title field, enter a title for the saved query.

Enter any optional information. Click a field name for a description of each
property.

Click Save Search.
The Locations page appears.
Do one of the following:

« To find specific containers, enter any part of a container title in the Search
field. Click the Go button.

« To display all containers, click Show All (if displayed).
« To display your favorite containers, click Show Favorites.

In the Possible Locations field, select the container(s) in which you want the
saved query to appear and click the Add button. To select multiple containers, use
the CTRL key (Windows) or the Command key (Macintosh).

In the Selected Locations field, select any containers in which you do not want
the saved query to appear and click the Remove button. To select multiple
containers, use the CTRL key (Windows) or the Command key (Macintosh).

Click Update Locations.

DocuShare adds your search query to the container. When you click the saved
query, DocuShare runs the search using the saved search terms and displays the
results.
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Using your personal home
page

About My DocuShare

My DocuShare provides a single location from which you can conveniently manage
personal content as well as access the content on your site. A link to My DocuShare
appears on the site home page, on the navigation bar, and under My Links on the page

footer.

11

My DocuShare consists of areas called portlets; each portlet has a different use. You can

close a portlet and reopen it by clicking the small triangle next to the portlet title.

Personal Collection—A collection for private content.
Workspaces—The workspaces you have access to and own.

Site Home—The top level collections on your site.

Favorite Calendars—A combination of the calendars in your Favorites.

Personal Trashcan—Your deleted objects.
Favorites—Links to your frequently used objects.
My Groups—The groups of which you are a member.

Tasks—The routing tasks assigned to you.
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Managing favorites

To conveniently access frequently used objects from a single location, you can add them
to your favorites. Any object you add as a favorite is a link to the original object, not a copy.
If the original object is deleted, it will no longer appear in your favorites.

To add an object to your favorites:

1.
2.

Locate the object that you want to add to favorites.
Do one of the following:
* Click the object’'s Add to Favorites icon.

« Click the checkbox that appears next to the object’s title. From the Edit
Selected menu, select Add to Favorites.

On the Confirm Add to Favorites page, click Confirm.
Go to My DocuShare.

The object you added appears under Favorites. The Show menu lets you display
one type of favorite object, such as favorite documents. You can click the
Favorites heading to display your favorites in a collection listing. In this view you
can use standard collection features.

To remove an object from your favorites:

1
2
3.
4

Go to My DocuShare.

Click the Favorites heading.

From the Edit Selected menu, select Remove Favorite.

On the Confirm Remove from Favorites page, click Confirm.

The object no longer appears in favorites. However, the object still appears in its
original location(s).
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Using your personal collection

Your personal collection on My DocuShare is a private repository for your objects. By
default, only you and a group of administrators called Content Administrators have full
access to the collection.

Note: Your administrator can choose to set up your site to not use personal collections.
To add an object to your personal collection:

Go to My DocuShare.
Click the Personal Collection heading.
From the Add menu, select the type of object you want to add.

On the Add page, enter the required information and click Apply.
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Go to My DocuShare.

The object you added appears under Personal Collection. The Show menu lets
you display one type of object, such as documents.

Note: You also can add an object to your personal collection using an object’s Locations
page. Display and select you personal collection in the Possible Locations field and then
click the Add and Update Locations buttons.

To view your personal collection in full page:

1. Go to My DocuShare.
2. Click the Personal Collection heading.

The objects display in a collection listing. In this view you can use standard
collection features such as adding new objects and changing the collection’s
properties.

Note: You can delete your personal collection and, optionally, its contents. However, the
next time you access My DocuShare your personal collection appears.
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Using your favorite calendars

All of your favorite calendars are combined and displayed in one calendar under the
Favorite Calendars heading. This allows you to merge the events from separate
calendars into a master calendar. For example, you can add individual vacation calendars
to your favorites to create a single vacation calendar for a group.

To add favorite calendars:

1.
2.

11-4

Locate the calendar that you want to add to favorites.
Do one of the following:
* Click the calendar’s Add to Favorites icon.

« Click the checkbox that appears next to the calendar’s title. From the Edit
Selected menu, select Add to Favorites.

On the Confirm Add to Favorites page, click Confirm.

Repeat steps 1 through 3 to add additional calendars to favorites.
Go to My DocuShare.

The single calendar appears under Favorite Calendars.

Using the Show menu, you can switch between daily and weekly views of the
calendar.
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Using your personal trashcan

Your personal trashcan holds both the objects you delete as well as the objects you own
that other users delete. You can use your personal trashcan to restore and expunge
deleted objects, provided your administrator has not expunged the objects from the site-
wide trashcan.

Note: Your administrator can choose to set up your site to not use personal trashcans.
To restore or expunge a deleted object:

1. Go to My DocuShare.
2. Under Personal Trashcan, select the object that you want to restore or expunge.
3. From the Action menu, do one of the following:
» Select Restore to restore the object to the location from which it was deleted.
+ Select Expunge to remove the object from your site.

Note: If the location is a collection or workspace and it was deleted, then the object is
restored to your personal collection. If the location is a non-collection type of container
(such as a calendar or a discussion) and it was deleted, then the object becomes an
orphaned object; your administrator can relocate an orphaned object.
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Viewing your groups

All of the groups of which you are a member display under the Groups heading. You can
click a group name to display its Properties page.

Viewing your routing tasks

All of the routing tasks assigned to you are listed under the Tasks heading. This provides
you with a quick view of the tasks to which you need to respond. You can click a task to
open its window.

In addition, clicking the Tasks heading displays the My Tasks window. You can view both
the tasks assigned to you and the tasks you assigned, and your routing task history in this
window. For more information on document routing, see Automating work processes.
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About archiving content

The DocuShare Archive Server enables your organization to conveniently increase
document storage capacity while providing a safe location for archived content. If your site
includes an Archive Server, you can move content from your site to a secondary server.
When you need to retrieve your archived content, you can search for the object and, if
needed, restore it.

Check with your DocuShare administrator to find out if your site uses an Archive Server.
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Archiving content

You can archive documents and email messages with attachments. When you archive a
document, all of its versions also are archived. To quickly archive the contents of a
collection, you can select the collection and archive it. However, only the documents and
email messages in the collection and its subcollections are archived; the collection is not
archived and remains on the DocuShare server.

There are two ways to archive content: Specify a date on which to have objects archived
automatically, or select the objects you want to archive and use the Archive command.
After an object is archived, it retains its properties, access list, and previous location on the
DocuShare server.

Archiving content automatically

By default, DocuShare uses the object's Expiration Date property to archive content
automatically. Your DocuShare administrator can specify a different date property to use
for archiving, so check with your administrator to find out which property you should use.

To archive content automatically:
Locate the object (document or email message) that you want to archive.
Click the object’'s Properties icon.

Click the Edit link.

In the appropriate date field, enter the date on which you want the object archived.
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Click Apply.

DocuShare archives the object on the date you specified.

Archiving content manually

To archive content manually:

1. Do one of the following:

« Navigate to and open the collection that contains the objects you want to
archive.

* Run a search to find the objects you want to archive.

* Navigate to (but do not open) the collection that contains the objects you want
to archive.

2. Do one of the following:

« To archive objects in an open collection or from a search, click the checkbox
that appears next to the title of each object.

« To archive the contents of a collection, click the checkbox that appears next to
the title of the collection.

3. From the Edit Selected menu, select Archive.

The Confirm Move to Archive page appears.
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Note: If a minus sign appears in the checkbox that precedes an object, then you
do not have manage permission to the object and cannot archive it.

4. Click the Confirm button to move the objects to the Archive Server.
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Restoring archived content

You can restore any object that you moved to the Archive Server to its previous location
on DocuShare. If the DocuShare collection in which the object was located was deleted,
you can add the object to another collection after restoring it. An object is restored with its
associated properties and access list. However, if a user who previously appeared in the
object’s access list was deleted from the DocuShare site, the user will not appear in the
restored object’s access list. Also, if you are restoring an object that was owned by
another user whose DocuShare account was deleted, you will become the new owner.

To restore an archived object:

1. On the navigation bar, click the Advanced link.
The Advanced Search page displays.
2. Specify the search terms and options you want.

Depending on the page from which you are running the search, select a search
scope from the Search Within menu.

Note: The search scope you select is used on the Archive Server. When an object
is archived, it retains its original location path. If you know any part of the object’s
location path, you can narrow the search scope to speed the search.

4. |Inthe Server to Search field, select Archive Server.
5. Click Search.

The Search Results page displays. The words Appeared In followed by the
collection name display under each object whose collection exists on DocuShare.
If Appeared In and the collection name do not display, then the object’s collection
was deleted. You can restore the object as an orphan and then add it to another
collection.

6. Select the objects to restore.
From the Edit Selected menu, select Restore.

8. On the Confirm Restore From Archive page, click Confirm.
The Archive Restore Results page displays.

9. If the object is an orphan, do the following:

a. Click the checkbox that precedes it.

b. From the Edit Selected menu, select Change Location.

c. On the Confirm Change Location page, click Confirm.

d. Use the Change Location page to relocate the orphaned object.

The Archive Restore Results page displays and lists the new collection in which
the object appears under the object’s title.
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Permissions required for tasks on a site using
three permissions

Table A—1 lists the permission required for each task on a site that is set up to use three
permissions.

Table A—1: Permissions required for tasks

User Task Reader Writer ETET [T

All Objects

Add object X

View object content

View object properties

Change object properties X

View object change history

View object permissions

Change object permissions

Change object owner

Change object location

object

current location (for copy)

current location (for move)

new location

Delete object X

Document

View document and versions X

Add new document version

Edit document

Lock document
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Permissions required for tasks on a site using three permissions

Table A—1: Permissions required for tasks

User Task Reader Writer Manager
Unlock document*
Export a document X
Route a document X
Approve or Disapprove X

Review and Make Changes

Acknowledge Receipt X

Information
Archive document, email message X
Restore archived document, email message X
Comment

Add comment to document, weblog entry

View comment on document, weblog entry

Content Rule

Create content rule X
View content rule X

Change content rule X
Notification

Add notification to object X

View object notifications

Create recipient list for notification

Scan Cover Sheet

Create and use scan cover sheet for object X

Weblog

Add weblog entry text

Edit weblog entry text

Approve weblog entry X

Wiki

Add wiki page X

Edit wiki page text

Rename wiki page

Delete wiki page X
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Permissions required for tasks on a site using three permissions

Table A—1: Permissions required for tasks

User Task Reader Writer Manager

Workspace

Re-assign membership group X

* Not controlled by permissions; user who locked the document and content
administrators can unlock the document.
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Permissions required for tasks on a site using six permissions

Permissions required for tasks on a site using
siX permissions

Table A-2 lists the permission required for each task on a site that is set up to use six

permissions.

[VELT @ F-T ¢

Table A-2: Permissions required for tasks

Read
Properties

Read
Content

Read
History

Write
Properties

Write
Content

Manage

All Objects

Add object

View object content

View object
properties

Change object
properties

View object change
history

View object
permissions

Change object
permissions

Change object
owner

Change object
location

object

current location
(for copy)

current location
(for move)

new location

Delete object

Document

View document and
versions

Add new document
version

Edit document

Lock document

Unlock document*

A4
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Permissions required for tasks on a site using six permissions

Table A-2: Permissions required for tasks

Read Read Read Write Write
Manage

Properties Content History Properties Content

Export a document

Route a document

Approve or
Disapprove

Review and Make
Changes

Acknowledge
Receipt

Information

Archive document,
email message

Restore archived
document, email
message

Comment

Add comment to
document, weblog
entry

View comment on
document, weblog
entry

Content Rule

Create content rule

View content rule

Change content rule

Notification

Add notification to
object

View object
notifications

Create recipient list
for notification

Scan Cover Sheet

Create and use
scan cover sheet for
object

Weblog
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Permissions required for tasks on a site using six permissions

Table A-2: Permissions required for tasks

User Task Read Read Read Write

Properties Content History Properties

Add weblog entry X
text

Edit weblog entry X
text

Approve weblog X
entry

Wiki

Add wiki page X

Edit wiki page text

Rename wiki page

Delete wiki page X
Workspace
Re-assign X

membership group

* Not controlled by permissions; user who locked the document and content
administrators can unlock the document.
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Using WebDAJV folders

DocuShare supports the WebDAV (Web-based Distributed Authoring and Versioning)
protocol, which enables you to access DocuShare collections and documents through a
WebDAV-compliant folder. You do not need client software installed on your computer.
Depending on your operating system, do one of the following:

* If you are a Windows XP user, simply go to My Network Places to add a
DocuShare server as a network place.

* If you are a Windows Vista user, open My Computer, right-click in the Network
Location pane, and select Add a Network Location to add a DocuShare server
as a network location.

» If you are a Macintosh OS X user, select Connect to Server to add the URL for a
DocuShare server.

Note: In both Windows and OS X, you must append the DocuShare server's URL with /
webdav. When you are prompted to log in, use your DocuShare username and password.

Document titles in WebDAYV folders

Your DocuShare administrator controls how document titles are displayed in collections.
For example, a title might have a file extension appended to it. If you have any questions
about how document titles are displayed, see your administrator.
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Accessing DocuShare in a portlet

If you use a desktop portal application, you can access DocuShare in a portlet. Before you
can use this feature, your DocuShare administrator and a portal administrator must set up
your site to support the feature.

To access DocuShare in a portlet:

1.

Set up your browser to accept cookies from your DocuShare server. Refer to your
browser documentation for details.

Launch your desktop portal application.
DocuShare appears in a portlet.

To change the view in the portlet, click the Edit button located in the upper-right
corner of the portlet.

From the Show menu, select the collection or workspace that you want to view.

In the Portlet Height (px) field, enter a number to change the height of the portlet.
The height is measured in pixels.

Click Submit.

The collection or workspace appears in the portlet. You can navigate the container
to view the content to which you have access.
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applying to document versions 4-11

changes processed in the background
4-8

Manage permission 4-3

Manager permission 4-3

Read Content permission 4-3

Read History permission 4-3

Read Properties permission 4-3

Reader permission 4-3

required for tasks on six-permission
site A-4

required for tasks on three-permission
site A-1

Write Content permission 4-3

Write Properties permission 4-3

Writer permission 4-3

personal collection 11-3

adding objects to 11-3
personal trashcan 4-15

using 11-5
placeholder document 5-2
portal application, and DocuShare C-1
portlet, accessing DocuShare in C-1
preferred version

and maximum versions 5-2
changing 5-7
defined 5-7

progress reports, viewing 9-6 to 9-7
properties

viewing and changing for objects 4-6
viewing and editing with document
content 5-3

Q

question mark, using in searches 10-7
quotas, usage, viewing 3-4, 3-9

R

Read Content permission 4-3
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Read History permission 4-3
Read Properties permission 4-3
Reader permission 4-3
Read-Only user 3-1

recipient list

changing for document routing 9-3
creating for notification 6-4

removing user account mapping from a
federated server 3-7
Rename (Edit Selected menu) 4-14
rendition
viewing for versions 5-8
viewing HTML 5-4
viewing PDF 5-4
reply
adding to topic 8-2
attaching documents 8-3
reserved characters, using in searches
10-7
Restore (Edit Selected menu) 4-14
restoring archived content 12-4
restoring deleted objects 4-15, 6-6, 9-15
retain login for future 2-4
Route (Edit Selected menu) 4-14
routed document
acknowledging receipt of 9-9
approving 9-8
disapproving 9-8
publishing new version of 9-7
removing after sent for information
9-10
reviewing 9-9
routing a document
about 9-1
automatically after adding to collection
9-4
including additional documents 9-2
routing order 9-2
to users 9-1 to 9-3
types of routing tasks 9-2
using a saved Routing Slip 9-2
Routing Slip 9-1
private 9-3, 9-4
re-using 9-2
saving 9-3
routing tasks
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checking status of your tasks 9-4 to 9-6
deleting completed 9-5

viewing all deleted 9-10

viewing for document 9-11

viewing tasks assigned to you 9-8, 11-6

RSS feed, See feed 6-1

S

saved query

adding to container 10-8
changing access list 4-8
changing its location 4-12
changing owner 4-9
changing properties 4-6
deleting 4-15
viewing change history 4-6
viewing properties 4-6
saved Routing Slip, using 9-2
saving
a Routing Slip 9-3
scanned document to a collection 5-16
search query 10-8

scan cover sheet
creating 5-13

deleting 5-14
using 5-2, 5-14

scan template 5-15
scanned document

checking length of time in temporary
collection 5-15

receiving URL after saving 5-16

saving to a collection 5-16

scanning documents

about 5-13
at a WorkCentre 5-15
using scan cover sheets 5-2, 5-13

Search Available To, defined 4-8
search words, separator 10-3
searches 10-1

See also saved query

how to specify exact word 10-5

running 10-3 to 10-6

saving 10-8

using non alphanumeric characters
10-7

using wildcards 10-7
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searching for objects 10-3 to 10-6

combining search terms 10-5 to 10-6
finding user and group accounts 3-14
on federated servers 10-3, 10-5 to 10-6
running a word search 10-3

using search options 10-4

shortcuts portlet (workspace) 7-1

adding objects to 7-6
changing properties 7-8
removing objects from 7-6

site-wide trashcan 4-15

snippet (document), showing and hiding in
search results 10-3, 10-6

stemming 10-1

T

tasks, See routing tasks
temporary scan collection

checking how long scanned
documents are stored 5-15
moving scanned document from 5-16

theme

and weblogs 8-5
and wikis 8-8
selecting for site 3-5

TIFF file, creating by scanning 5-15
tilde, use of in searches 10-3, 10-5
topic

adding to discussion 8-2
attaching documents 8-3
changing access list 4-8
changing owner 4-8
deleting expired 8-3
replying to 8-2

viewing expired 8-3

trashcan

personal 4-15
site-wide 4-15

U

unlocking a document 5-9
uploading a document 5-2
URL
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adding 4-4

changing access list 4-8
changing its location 4-12
changing owner 4-9
changing properties 4-6
deleting 4-15

viewing change history 4-6
viewing properties 4-6

usage quotas, viewing 3-4, 3-9
user account

and user levels 3-1
changing domain 3-5
changing password 3-3
changing properties 3-3
changing username 3-4
creating 3-2
mapping to federated server 3-6
removing user account mapped to
federated server 3-7
searching for 3-14
using a theme 3-5
viewing activity history 3-5
viewing list of 3-14
viewing properties 3-3
viewing usage quotas 3-4
user icon, and indication of logged-in status
3-14,7-3
user levels 3-1
username, changing 3-4

\'

version comments, adding 5-5, 5-6
version history, viewing 5-7
version, document

adding edited document 5-5
adding new document 5-6
changing preferred version 5-7
changing properties 5-8
publishing routed document 9-7
specifying maximum to save 5-2
viewing 5-7
viewing properties 5-8
viewing renditions 5-8

viewing
a document 5-3
a document in HTML format 5-4

a document in PDF format 5-4
access list 4-7
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document comments 5-12

document content and properties 5-3

document version history 5-7

duplicate documents 5-10

expired topics 8-3

new content 10-2

progress reports for routing tasks 9-6 to
9-7

version renditions 5-8

your activity history 3-5

viewing properties

group account 3-9
notification 6-5
object 4-6

user account 3-3

W

WebDAV folder, using with DocuShare B-1
weblog

about 8-5

adding to container 8-5
and site themes 8-5
changing its location 4-12
changing properties 4-6
deleting 4-15

moderated 8-5

posting entries 8-5
viewing change history 4-6
viewing properties 4-6

weblog entry

adding comment to 8-7
adding to weblog 8-5
approving 8-6
deleting 8-6
editing 8-6
week view, calendar 4-5, 7-7
What's New
using 10-2
wiki
about 8-8
adding content 8-8
adding to container 8-8
and site themes 8-8
attaching documents 8-10
changing its location 4-12
changing page name 8-11
changing properties 4-6
deleting 4-15
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editing methods 8-8
inserting images 8-10
linking pages 8-8

printing wiki pages 8-11
using interwiki links 8-11
viewing change history 4-6
viewing linked pages 8-9
viewing properties 4-6

wiki syntax, and wikis 8-8
wildcards, using in searches 10-7

WorkCentre, and scanning documents
5-15
workflow, See routing a document
workspace
about 4-1, 7-1
adding 7-2
adding content 7-5
adding shortcuts 7-6
changing membership group members
7-3t0 7-4
changing portlet properties 7-8
controlling access to 7-3
re-assigning membership group 7-4
removing shortcuts 7-6
viewing calendars 7-7
Write Content permission 4-3
Write Properties permission 4-3
Writer permission 4-3

WYSIWYG editor, and wikis 8-8
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